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Chapter 1: Digital Publishing Suite 
overview

The Adobe Digital Publishing Suite lets mobile device viewers engage with interactive content in a magazine format. 

Creative designers who publish print magazines using Adobe® InDesign® CS5 or InDesign CS5.5 can make that content 

available on mobile devices. Publishers can supplement their designs with interactive content, allowing their audience 

to view media in an entirely different way. Customers can use hand gestures to flip through a slideshow, pan images, 

rotate objects 360°, and more.

Prepare to use the Digital Publishing Suite

Before you start creating digital publications, install the required tools, obtain and use the appropriate Adobe ID, and 

learn the essentials.

Related Articles

Overview of digital publishing workflow

Adobe InDesign is the central component of the workflow. Using InDesign CS5.5 or InDesign CS5, design teams 

create layouts and add interactivity. With layouts in hand, production teams assemble the layouts, add metadata, and 

publish them into a “folio” format.

Anyone who uses InDesign CS5 or later can author, preview, and share digital publishing content. However, only users 

who subscribe to the Adobe Digital Publishing Suite can create custom viewers for commercial use.

To do this: Go here:

Understand the digital publishing workflow “Overview of digital publishing workflow” on page 1

“Getting started with the Digital Publishing Suite” on page 7

Single Edition overview “Single Edition overview” on page 8

Install the Folio Producer tools “Installing digital publishing tools” on page 3

Use a valid Adobe ID “Using Adobe IDs for digital publishing” on page 5

Install Adobe Content Viewer on mobile devices “Preview folios and articles” on page 65
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Getting your InDesign layout onto your iPad

Step 1: Install Folio Producer tools

If you’re new to the Digital Publishing Suite, install the newest version of both the the Folio Producer tools and the 

Folio Builder panel. The Folio Producer tools installer installs the Overlay Creator panel, a required plug-in, and the 

Desktop Viewer. The Folio Builder panel installer installs only the Folio Builder panel. See “Installing digital 

publishing tools” on page 3.

The Folio Builder panel may need to be updated when the Folio Producer Service on the web is updated. During new 

releases, installing a new version of the Folio Producer tools is optional.

A verified Adobe ID is required to sign in to the Folio Builder panel and Dashboard. Use a different Adobe ID for each 

publication. If you do not have a verified Adobe ID, go to https://digitalpublishing.acrobat.com/, click Create Account, 

and follow the prompts.

If you have an iPad, an Android device, or a PlayBook, install the most current version of the Adobe Content Viewer 

from the store (Apple App Store, Android Market, Amazon Appstore, or BlackBerry App World).

Step 2: Create source documents in InDesign CS5

Create InDesign documents as the base layout for the digital content. You can create both a portrait (vertical) and 

landscape (horizontal) layout in separate documents for each article. Or, you can limit your design to a single 

orientation. See “Designing digital publications” on page 22.

In addition to using InDesign files as source content, you can also create HTML articles. See “Import HTML articles” 

on page 59.

Step 3: Add interactive objects

Use the Overlay Creator panel to create and edit interactive objects. Not all InDesign interactivity features are 

supported. See “Interactivity” on page 33.

To see examples and how-to instructions for each overlay type, download the Digital Publishing Suite Tips app on 

your iPad and view the Interactive Overlays folio.

InDesign Adobe Viewer Custom Viewer

Authoring

Folio

Production

Article 1 Article 2 Article 3

Folio
Builder

Overlay
Creator

https://digitalpublishing.acrobat.com/
http://goo.gl/qasog


3USING DIGITAL PUBLISHING SUITE

Digital Publishing Suite overview

Last updated 11/16/2011

Step 4: Use the Folio Builder to create folio and articles

Use the Folio Builder to create or open a folio and add articles. Each article can have two layouts for horizontal and 

vertical orientations. Folios you create are uploaded to the web. Adobe Digital Publishing Suite is powered by 

Acrobat.com. See “Folios and Articles” on page 53.

You can also edit folios using the Folio Producer Organizer at http://digitalpublishing.acrobat.com. See “Folio 

Producer Organizer” on page 74.

Step 5: Preview articles

To preview the folio using the Desktop Viewer, select a folio or an article in the Folio Builder panel and click Preview. 

Press Ctrl/Command+R to rotate the orientation. See “Use the Desktop Viewer to preview content” on page 65.

To preview the folio on mobile devices such as the iPad, install the Adobe Content Viewer on the device, and then sign 

in using the same Adobe ID you used to sign in to the Folio Builder panel. Folios you create or that other share with 

you are available for downloading. See “Preview folios and articles” on page 65.

Step 6: Share the folio with others for previewing

Use the Share command in the Folio Builder panel to share a folio with other people. Anyone with a valid Adobe ID 

can view the folio you share with them for free. When they use the Adobe ID to sign in to the Adobe Content Viewer, 

any folios you shared with them are available for downloading. See “Share folios” on page 56.

Step 7: Make folios available to customers (Subscribers only)

Use the Folio Producer Organizer to put the finishing touches on the folio and publish it to the Distribution Service to 

make it publicly available. See “Assemble and Publish” on page 69.

Use the Viewer Builder to create a custom viewer app that you can submit to the Apple Store, Android Market, or 

BlackBerry App World. You can enable subscriptions, push notifications, and Omniture analytics. See “Viewer 

Builder” on page 84.

Step 8: Analyze customer data and add and update folios (Subscribers only)

After you publish your folio, use the Analytics page on the Digital Publishing Suite Dashboard to track user data. See 

“Omniture analytics” on page 97.

Continue to add folios to your custom viewer.

Installing digital publishing tools

The Adobe Digital Publishing Suite is available for both InDesign CS5 and InDesign CS5.5. To install the full set of 

digital publishing tools, two separate installations are required. First, install the Folio Producer tools. Then, install the 

Folio Builder panel. 

Note: If you used the prerelease tools, installing the Folio Producer tools disables the Content Bundler. If you still need to 

use the Content Bundler to publish folios, finish your work before you install the new tools on the same computer.

AIR 2.x is required to run AIR applications such as the Desktop Viewer. AIR 2.x is available at 

http://get.adobe.com/air/.

If you experience problems installing the tools, see Troubleshoot Installation.

https://digitalpublishing.acrobat.com
http://get.adobe.com/air/
http://kb2.adobe.com/cps/900/cpsid_90002.html
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Installing the Folio Producer tools for the first time

1 Exit InDesign.

For best results, exit all Adobe applications.

2 Install the Folio Producer tools.

Windows: Download Folio Producer tools (Windows)

Mac OS: Download Folio Producer tools (Mac OS)

Unless you have a good reason to use an older set of tools, such as ensuring compatibility with an existing viewer 

app, install the most recent update of the tools.

The Folio Producer tools installer installs the Overlay Creator panel, a required InDesign plugin, and the Desktop 

Viewer.

3 Install the Folio Builder panel.

Windows: Download Folio Builder panel (Windows)

Mac OS: Download Folio Builder panel (Mac OS)

Installing the Adobe Content Viewer on a mobile device

If you have an iPad, an Android device, or a PlayBook, install the most current version of the Adobe Content Viewer 

from the store. In App Store, Market, or App World, search for “Adobe Content Viewer.”

Updating the Folio Builder panel and/or the authoring tools

The Digital Publishing Suite tools are updated frequently. Whenever there is a new release, the Folio Producer Service 

is updated on the web. There is a separate installer for the Folio Builder panel so that you can update the panel 

separately. Whenever Adobe updates the Folio Producer on the web, update the Folio Builder panel to make sure that 

the web client and the Folio Builder panel remain in sync.

Note that updating the Folio Builder panel does not update your authoring tools. 

The Folio Builder panel updates are available on the Adobe Downloads pages:

Windows: Download Folio Builder panel (Windows)

Mac OS: Download Folio Builder panel (Mac OS)

You also have the option of updating the authoring tools when a new version is released. When you update the 

authoring tools, any folio you publish is no longer compatible with a custom viewer created with a previous set of tools. 

For example, suppose that you used Viewer Builder 1.2 to create a custom viewer that you submitted to the app store. 

To continue creating folios for that custom viewer, keep using the v12 Folio Producer tools (installer 1.0). Do not 

update to installer 1.1 or later until you are ready to create and submit a new version of the custom viewer to the store. 

However, you should update the Folio Builder panel whenever the Folio Producer is updated on the web.

You may need to revert to a previous set of Folio Producer tools to be compatible with an older custom viewer. 

Uninstall the Folio Producer tools, and then download and install the appropriate version. 

Uninstalling the Folio Producer tools (InDesign CS5)

In InDesign CS5, the Folio Producer tools are installed separately from InDesign. To uninstall the Folio Producer tools 

for InDesign CS5, do either of the following:

• In Windows, use the Control Panel (Add/Remove Programs) to uninstall the Adobe Folio Producer tools.

• In Mac OS, use the uninstaller located in Applications > Utilities > Adobe Installers.

http://www.adobe.com/support/downloads/product.jsp?product=172&platform=Windows
http://www.adobe.com/support/downloads/product.jsp?product=172&platform=Macintosh
http://www.adobe.com/support/downloads/product.jsp?product=180&platform=Windows
http://www.adobe.com/support/downloads/product.jsp?product=180&platform=Macintosh
http://www.adobe.com/support/downloads/product.jsp?product=180&platform=Windows
http://www.adobe.com/support/downloads/product.jsp?product=180&platform=Macintosh
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Uninstalling the Folio Producer tools (InDesign CS5.5)

In InDesign CS5.5, the Folio Producer tools are part of the InDesign program. To uninstall the Folio Producer tools, 

uninstall InDesign (or the Creative Suite).

• In Windows, use the Control Panel (Add/Remove Programs) to uninstall InDesign CS5.5.

• In Mac OS, use the uninstaller located in Applications > Utilities > Adobe Installers.

Using Adobe IDs for digital publishing

The Folio Builder panel, Digital Publishing Suite Dashboard, and Viewer Builder all require a verified Adobe ID to 

sign in.

Adobe ID tied to application

You can use an Adobe ID for an individual (such as “johnsmith@gmail.com”) to sign in to the Folio Builder panel and 

create folios. However, if you’re publishing a multi-folio viewer app, such as a monthly magazine, we recommend that 

you use an Adobe ID specifically for that application, such as “dps.publication@publisher.com”).
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Application Adobe ID
A. Folio Builder panel  B. Viewer Builder  C. Custom viewer app created with Viewer Builder displays folios created with Folio Builder panel  

The Adobe ID you use to sign in to the Folio Builder panel is tied to the Adobe ID you specify when creating the viewer 

app in Viewer Builder. For example, suppose that you belong to a company called Sporty and you publish magazines 

about kayaking and cycling. For best results, create one Adobe ID called “dps.kayaking@sporty.com” and another 

called “dps.cycling@sporty.com.” When creating folios about kayaking, you use the kayaking Adobe ID when signing 

in to the Viewer Builder panel and Dashboard. When creating the custom viewer app for kayaking, you specify the 

kayaking Adobe ID in the Basic Details panel of the Viewer Builder. (The Adobe ID you use to sign in to the Viewer 

Builder may be a different Adobe ID.)

If you have already created a custom viewer, continue to use the same Adobe ID for that viewer.

A B

C
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Creating and verifying an Adobe ID

To create Adobe IDs, go to https://digitalpublishing.acrobat.com/ and click Create Account. Sign up for an account 

using a valid email address. Adobe will send you a verification message. Open that message and verify it. Use the Adobe 

ID to sign in to the Folio Builder panel or Dashboard. If you’re a Professional or Enterprise subscriber, contact your 

Adobe representative to provision that Adobe ID appropriately so that you can publish folios or download and sign in 

to the Viewer Builder. 

More Help topics 

“Account Administration tool” on page 98

Getting started with the Digital Publishing Suite

Video tutorials

Colin Fleming created a series of videos on using the Digital Publishing Suite tools. These video tutorials and others 

are available on AdobeTV.

AdobeTV - Learn Digital Publishing Suite

AdobeTV - Digital Publishing Channel

Web tutorial

Download sample assets and step through Authoring Tutorials.

More Help topics 

“Digital Publishing Suite resources” on page 7

Digital Publishing Suite resources

In addition to this help system, the following digital publishing resources are available:

User forums

Go to the public Digital Publishing Suite user forum to ask questions and participate with other customers.

Adobe websites

• The Digital Publishing Suite Help and Support page provides common support questions and links to useful 

articles and content.

• The Digital Publishing Suite product page offers overview examples, pricing information, a digital publishing FAQ 

page, and more.

• The Digital Publishing Gallery provides links to the publications created using the Digital Publishing Suite tools.

To learn about the digital publishing process and experiment with sample files, go to DPS Authoring Tutorials.

The Digital Publishing Suite Tips app is available in the Apple App Store. It’s like a combination of a user guide, a blog, 

and a cookbook. This app is also available in Android Market (search in Market for “DPS Tips”).

Follow the Digital Publishing Suite Twitter feed or the Digital Publishing Suite Facebook page.

https://digitalpublishing.acrobat.com/
http://tv.adobe.com/show/learn-digital-publishing-suite/
http://tv.adobe.com/show/digital-publishing/
http://help.adobe.com/en_US/digitalpubsuite/tutorials/WS4eecfe2929bd9591-15ce9b4d12f983dd70b-8000.html
http://forums.adobe.com/community/dps
http://www.adobe.com/support/digitalpublishingsuite/
http://www.adobe.com/products/digitalpublishingsuite/
http://blogs.adobe.com/digitalpublishinggallery/
http://www.adobe.com/go/learn_dps_vidtut_en
http://goo.gl/qasog
http://twitter.com/#!/adobedigitalpub
http://www.facebook.com/adobedigitalpub


8USING DIGITAL PUBLISHING SUITE

Digital Publishing Suite overview

Last updated 11/16/2011

Documents about publishing viewer apps

• This Publishing for iPad Viewer companion guide walks you through the steps of creating the required certificates, 

splash screens, and icons for submitting a custom viewer app to the Apple App Store. The companion guide for 

downloading on the Dashboard.

• The Publishing Process for Android Mobile Devices Guide explains how to create a custom viewer app to submit 

to the Android Market.

• The Publishing Process for BlackBerry PlayBook Mobile Devices explains how to create a custom viewer app to 

submit to BlackBerry App World.

More Help topics 

“Getting started with the Digital Publishing Suite” on page 7

Digital Publishing Suite pricing options

How much does it cost to use the Digital Publishing Suite? It depends on what you’re trying to do. Here are the options:

Free If you have InDesign CS5 or later, you can install the digital publishing tools for free. You can create folios, 

preview them on your desktop and mobile devices, and share them with individuals. It costs money only if you want 

to publish folios and create custom viewer apps that you can submit to stores.

Single Edition Pay a one-time fee of $395 to create a custom application for the iPad that contains a single folio. See 

“Single Edition overview” on page 8.

Professional Edition With the Professional Edition subscription, you pay $495 a month to create an unlimited number 

of custom viewer apps. You can build either single-folio apps or multi-folio apps for the iPad. You can build multi-

folio apps for Android, Amazon, and PlayBook platforms. You can also create multi-folio subscription apps for the 

iPad and Amazon stores. With the Professional Edition, you get basic analytic reports to track user data.

Enterprise Edition Enterprise Edition includes everything in Professional Edition, plus the ability to customize the 

Viewer UI, create custom entitlement servers, create in-house enterprise apps, and obtain detailed analytic reports.

Click here for more information on pricing: www.adobe.com/products/digitalpublishingsuite/pricing/

More Help topics 

“Types of custom viewer apps” on page 69

“Getting started with the Digital Publishing Suite” on page 7

Single Edition overview

The Single Edition model provides small to midsize design studios and freelance designers a way to deliver brochures, 

catalogs, portfolios, training materials, and books to the iPad. Pay a one-time fee of $395 to create a custom application 

for the iPad that contains a built-in folio.

Single Edition is currently available only in North America. Go to the Adobe website to purchase your Single Edition 

serial number or to find out when it will become available in your region.

http://www.adobe.com/go/learn_dps_dashboard_en
http://kb2.adobe.com/cps/900/cpsid_90052.html
http://kb2.adobe.com/cps/915/cpsid_91589.html
http://www.adobe.com/products/digitalpublishingsuite/pricing/
http://www.adobe.com/products/digitalpublishingsuite/features/index.html?digital_publishing=single
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Requirements

What you’ll need to create your folio:

• InDesign CS5 or InDesign CS5.5.

• Folio Producer tools (Overlay Creator panel and Viewer Builder panel).

• An Adobe ID for signing in to the Folio Builder panel and the Dashboard on the web.

• An Internet connection.

What you need to build your app:

• A Mac OS computer running Mac OS X 10.6 (Snow Leopard) or 10.7 (Lion).

• Viewer Builder app (available on Dashboard).

• Membership to Apple’s iOS Developer Program ($99 per year). See http://developer.apple.com/programs/ios/.

• A Single Edition serial number. 

Steps to create a single-folio viewer app

Follow these general steps to create your custom viewer app and submit it to the Apple Store.

Step 1: Understand the Basics Before you start using InDesign to create content, get a basic understanding of the 

process. Watch videos, step through tutorials, and browse through help topics. See “Getting started with the Digital 

Publishing Suite” on page 7.

Use the DPS Tips app and other resources to learn the basics.

Step 2: Install the Folio Producer Tools  To install the necessary tools, run two separate installers. First, install the Folio 

Producer tools to add the Overlay Creator panel, a required InDesign plugin, and the Desktop Viewer. Then install the 

Folio Builder panel. See “Installing digital publishing tools” on page 3.

Install the digital publishing tools to work with InDesign.

http://developer.apple.com/programs/ios/
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In addition, download the Adobe Content Viewer to your iPad. When you create a folio, the content is uploaded to a 

web client powered by acrobat.com. Use the viewer to download and preview that folio. Search for “Adobe Content 

Viewer” in the iPad App Store or in the iTunes Store.

Step 3: Obtain a Valid Adobe ID Use or create a verified Adobe ID to sign in to the Folio Builder panel and the DPS 

Dashboard on the web. See “Using Adobe IDs for digital publishing” on page 5.

Use a verified Adobe ID to sign in.

Step 4: Create, Publish, and Export Your Folio Use the Folio Producer tools to create your folio. Preview your folio 

using the Adobe Content Viewer. 

When you finish your folio, use the Folio Producer Organizer on the web to publish the folio. Then export the 

published folio as a .zip file.

Use the Folio Producer Organizer to publish and export your folio.

Step 5: Subscribe as an Apple Developer To create the required certificates and submit your app to the App Store, you 

need to obtain an Apple developer subscription, which costs $99 a year.



11USING DIGITAL PUBLISHING SUITE

Digital Publishing Suite overview

Last updated 11/16/2011

Sign up at developer.apple.com.

Step 6: ObtainYour Single Edition Serial Number Use the Adobe website to purchase your Single Edition serial 

number. If Single Edition is not yet available in your region, sign up to be notified when it becomes available.

Obtain the Single Edition serial number required to build the app.

Step 7: Create the Required Files Use the Apple Developer site to create the required certificates for submitting your 

app. Create the required splash screens and icon images. See “Checklist for single-folio viewer (iPad only)” on page 81.

To build your app, you need to provide certificates and image files.

Step 8: Install the Viewer Builder After you create your folio, you'll use the Viewer Builder to create the app that you 

submit to the App Store. Download the Viewer Builder from the DPS Dashboard, and run through the wizard to build 

your app.

http://www.adobe.com/products/digitalpublishingsuite/features/index.html?digital_publishing=single
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Use the Viewer Builder to build your app.

Step 9: Submit the viewer app to Apple Use the Viewer Builder to download the .ipa file and test it on your iPad. If it 

works as designed, download the .zip file and submit it to Apple using the iTunes Connect site.

Download the .ipa file for testing and the .zip for submitting to Apple.

For details on creating certificates and submitting your viewer app to Apple, download the iPad Publishing 

Companion Guide PDF on the DPS Dashboard.

What’s new in this release

The Digital Publishing Suite tools are updated frequently. Whenever Adobe updates the Folio Producer on the web, 

update the Folio Builder panel to make sure that the web client and the Folio Builder panel remain in sync. (See 

“Installing digital publishing tools” on page 3.) Note that updating the Folio Builder panel does not update your 

authoring tools.

For a compilation of release notes, see “History of new feature release notes” on page 13.

Single Edition Instead of paying a monthly subscription to Adobe for a Professional or Enterprise account, you can 

now pay a one-time fee of $395 to create a single-folio viewer app that you can submit to the Apple Store. This option 

is currently available only in North America. See “Single Edition overview” on page 8.

Viewer Builder support for Amazon Appstore In Viewer Builder, you can create a custom viewer app that you can 

submit to the Amazon Appstore. The Amazon Appstore is available on Android devices as well as the Amazon Fire 

tablet. See “Create a custom viewer app for Android and Amazon devices” on page 90.

Account Administration tool Use the Adobe Account Administration tool to create and provision accounts for your 

company rather than exchanging email messages with Adobe representatives. You can assign three types of accounts 

to an Adobe ID: Application, Viewer Builder, and Administrator. See “Account Administration tool” on page 98.

http://digitalpublishing.acrobat.com
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Scrollable frames with interactive overlays If you install the v17 Folio Producer tools, you can include any overlay in 

a scrollable frame overlay except slideshows. See “Scrollable frame overlays” on page 49.

Right Edge Binding option Selecting this option in the Folio Producer Organizer displays articles from right to left 

rather than left to right in the viewer. This option is especially important for Asian languages. See “Change folio 

publishing settings” on page 74.

Open Folio Producer Organizer from panel Choosing the Folio Producer command from the Folio Builder panel 

menu opens the Folio Producer Organizer in your default web client.

Download counter For Professional and Enterprise customers, the DPS Dashboard displays the number of downloads 

you have available.

Improvements to server reliability The product team continues to make fixes to improve the acrobat.com 

upload/download issues. 

History of new feature release notes

The Digital Publishing Suite tools are updated frequently. To view a description of the new features in the current set 

of tools, see “What’s new in this release” on page 12.

Release 16

Offline workflow You can now create a folio and articles without uploading the content to the web server. When 

you’re ready, you can upload the content.

Newsstand support The updated Viewer Builder (version 1.5.1) includes Newsstand support for subscription viewer 

apps on the iPad. Newsstand-enabled viewers appear in the Newsstand folder, allowing quick access to newspaper and 

magazine publications.

Private publishing for non-subscription users If you don’t have an Enterprise or Professional subscription, you can 

use the Publish option in the Folio Producer Organizer to publish content as private. This option is especially useful if 

you are unable to download large folios using the acrobat.com server. Published folios downloaded from the Adobe 

Distribution Service are fast and reliable.

New option for audio assets If you’re using InDesign CS5.5, selecting the Show First Image Initially option resizes the 

audio overlay frame based on the first _play image in the specified audio controller assets folder. In InDesign CS5, you 

still need to manually resize the overlay frame to fit the poster image.

Import HTML Resources option in Folio Builder panel You can now import the HTML Resources file in the Folio 

Builder panel as well as the Folio Producer Editor.

Enhanced Dashboard The Digital Publishing Suite Dashboard includes links to videos and other useful content.

Separate installers for authoring tools and panel Use one installer to install the authoring tools (Overlay Creator 

panel, InDesign plug-in, and desktop viewer). Use a different installer to install the Folio Builder panel.

Improvements to server reliability The product team continues to make fixes to improve the acrobat.com 

upload/download issues. For example, publishing a folio now copies the folio contents directly from the acrobat.com 

server to the Adobe Distribution Service.

New analytics categories In analytics reports, you can view data regarding the type of downloaded folio: free, retail 

single, subscription, or external entitlement.
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Release 15

Custom viewers for PlayBook With the Viewer Builder, you can create custom viewer apps for iPad, Android, and 

BlackBerry PlayBook platforms. 

Enhanced scrollable frames You can now create scrollable content by pasting a text frame into a container frame. In 

addition, the performance of scrollable frames has improved.

Hyperlinks in scrollable frames Hyperlinks and hyperlink buttons in Pan Only scrollable frames are now supported. 

Hyperlinks in slideshows or in scrollable frames created using the Layers panel are not yet supported.

Improved memory handling In previous releases, creating memory-intensive overlays on adjacent pages caused 

performance problems in some situations. The viewer now handles these situations better, resulting in improved 

performance.

Preview on Device You can copy folio information directly to a connected mobile device without going through the 

acrobat.com web client. Until an updated Adobe Content Viewer is available in the App Store, the Preview on Device 

feature works only with Android devices. This initial offering requires additional setup effort.

Customize all five nav bar icons When using Viewer Builder to create a custom app, you can now replace the “Library” 

and “Viewer” buttons in the viewer nav bar (Enterprise only).

Simplified creation of in-house viewer apps You are no longer required to specify distribution certificates and 

provisioning files for Enterprise-signed viewer apps (Enterprise only).

Improved Omniture analytics User data is now available for single-folio viewer apps (DPS subscribers only). Also, 

analytics includes a more detailed breakdown of download statistics.

Option to turn off “Sign In” button If you’re an Enterprise customer creating a custom entitlement viewer, you can 

turn off the Sign In button to avoid redundancy.

Add certificates at download You now use Viewer Builder to create a custom viewer app file without specifying 

certificates. You then specify certificates when you download the viewer file. This allows different people to download 

and sign the app with certificates. 

When you create a custom viewer, you no longer need to click the Refresh button to see if the viewer build is complete.

Improved library performance In some instances, folios from acrobat.com were appearing only intermittently in the 

library. The Adobe Content Viewer should display all available folios consistently.

Improvements to HTML articles in Android viewer Scrolling is now enabled in HTML articles for the Android viewer.

Release 14 (Services and Viewer Builder only)

Rearrange article order You can now rearrange the order of articles directly in the Folio Builder panel, not just in the 

web client. Simply drag and drop the articles to change their order.

Unshare folios  If you shared a folio with someone else, you can unshare the folio without having to delete it. You can 

also use the Folio Builder panel to remove a folio that was shared with you. 

Change of article size limitation With previous releases, the size limit of an article to be uploaded was 100MB. The 

article size limit is now 2GB. However, mobile devices may not handle large articles well.

In-app payments for Android viewers You can now create retail folios for Android viewers. Customers can click a Buy 

button in the Android viewer library to purchase a folio.

Restore all purchases for Android viewers Customers can now restore all purchases in Android viewers as they can do 

in iPad viewers.
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Export option for single-folio viewers An Export option now appears in the Folio Producer Organizer. Clicking 

Export creates a .zip file containing the contents of the selected folio. When using the Viewer Builder to create a single-

folio viewer for the iPad, you specify this .zip file (or a .folio file created with the Content Bundler).

Sideloading option in development builds When you use the Viewer Builder to create a development viewer for the 

iPad, you can turn on sideloading. This option lets you manually copy a .folio file (not a .zip file) to the development 

viewer through iTunes.

Control language listing in iTunes In previous versions, the viewer app appeared in 20 languages in the iTunes Store. 

The Viewer Builder now lets you limit which languages the viewer app should appear in.

Restore purchases menu option The library of custom viewers now includes a menu that lets customers choose a 

Restore Purchases option to manually restore purchases.

Analytics update Subscription data is now captured in addition to individual folio statistics.

Release 13

Release 13 (June 2011) was the second public release of the Digital Publishing Suite. Release 13 tools used the 1.1.x 

installer and Viewer Builder 1.3.

Viewer download improvements Customers can begin viewing a folio before it finishes downloading, and they can 

view partially downloaded folios offline. Interrupted downloads are automatically resumed when the iPad is regains 

its connection to the Internet. Use the Folio Producer Editor to determine the download priority for articles.

Stop on last image With the Overlay Creator panel, you can now decide whether to stop slideshows and image 

sequences on the first or last image when played.

Horizontal Swipe Only articles in all viewers Articles set to Horizontal Swipe Only (“flattened articles”) now work in 

the Adobe Content Viewer for the Desktop, as well as for Android and PlayBook viewers.

Restore Purchases option If customers restore or replace an iPad, they can download content they’re entitled to more 

easily. When the viewer is started the first time, customers are prompted to restore purchases.

Custom navigation toolbar buttons Enterprise customers can create as many as three buttons that display an HTML 

page in the viewer. In addition to the Library and Viewer buttons that appear in the navigation toolbar, you can create 

additional buttons such as Store, Help, and News that display an HTML page.

Hide the navigation toolbar or Home button When using the Viewer Builder to create your viewer app, you can hide 

the navigation toolbar at the bottom of the viewer or the Home button in the upper left corner of the viewer.

Additional analytics reports The Analytics page on the Digital Publishing Suite Dashboard now includes more reports 

for tracking user data.

Entitlement for Android Enterprise customers can now provide entitlement for subscriptions.

Localized Android Content Viewer The Adobe Content Viewer for the Android is now localized for the same 

languages as the iPad viewer.

Localized Viewer Builder The Viewer Builder has been localized for the following languages: French, German, Italian, 

Spanish and Japanese.

Improved usability The Folio Builder panel, Folio Producer website, and Viewer Builder include a number of 

adjustments to improve the user experience.
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Release 12

Release 12 (May 2011) was the first public release of the Digital Publishing Suite. Release 12 tools used the 1.0.x installer 

and Viewer Builder 1.2.

New Folio Builder panel The Folio Builder panel in InDesign replaces the Digital Content Bundler application. With 

the Folio Builder panel, you can add articles and article layouts and change folio and article properties.

Folios stored on web workspace With the previous tools, you created a folio folder containing article folders. You 

bundled the folio folder to create .folio files that you either uploaded to the server or sideloaded to the iPad.With the 

new workflow, each folio is a workspace on a web server. The folios still consist of articles, but the articles can be copied 

to different folios and rearranged without bundling again. Click a Preview button to preview individual articles or 

entire folios. Or, sign in to the Adobe Content Viewer and download folios you created. You can use the Import feature 

to create articles based on existing folder structures.

Digital Publishing Suite web client Subscribers to the Digital Publishing Suite can sign in to the web client at 

http://digitalpublishing.acrobat.com. The Dashboard includes links to tools and services.

• Use the Analytics page to track customer data.

• Use the Folio Producer to organize, edit, and publish folios. The Folio Producer includes an Organizer page that 

displays available folios and an Editor page that displays the articles in a selected folio.

• Use the Viewer Builder to create custom apps.

Sharing Use the Share option to share folios with other DPS users. For example, a publisher can share a folio with a 

designer who is assigned to create an article for a magazine. Or, an ad agency can share a folio with various publishers 

to make ads available. The share workflow replaces the “sideloading” workflow.

Redesigned Overlay Creator panel The Overlay Creator panel has been redesigned. 360 Viewer overlays are now 

called Image Sequence overlays. Web View overlays are now called Web Content overlays. You can reset objects to 

convert them from overlays to normal objects.

Terminology changes “Stacks” are now called “articles.” The Flatten option is now Swipe Horizontal Only. The 

fulfillment server is now called the Distribution Service.

Release 11

Release 11 was the final prerelease version of the Digital Publishing Suite to use the Content Bundler workflow.

Folio download improvements On iPads, the download speed has doubled. In addition, Viewer users can read one 

folio while downloading another.

Android Viewer enhancements The performance of PNG and HTML articles on Android devices has improved. The 

Android Viewer supports in-app web view.

Navigation bar customization Enterprise customers can add as many as three icons to the navigation bar that display 

a full-screen web view.

Subscription improvements You can now set up an Apple (iOS) subscription without providing a custom entitlement 

server.

Release 10

Pinch and zoom in PDF folios If you select the PDF export option while bundling, users can use the pinch gesture to 

zoom in on a page. At this time, pinch and zoom is not enabled on pages that have interactive overlays.

Content Viewer for Android The Adobe Content Viewer is now available for Android devices. You cannot sideload 

folios to this Content Viewer. Instead, upload and download files using the fulfillment server. Although the Android 

Viewer more closely matches the iPad Viewer, some features are not yet supported. Unsupported features include 
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flattened articles, inline videos, panorama overlays, and folios exported in PDF format. HTML articles and Web View 

overlays may have performance issues.

Localized viewers The Adobe Content Viewer language interface changes based on the device’s locale settings. At this 

time, supported languages include English, French, German, Swedish, Spanish, and Japanese.

Additional subscription support In-app subscription options are now available. Adobe supports Apple’s new 

subscription model for publishers who set up their own entitlement server.

Folio renditions Mobile devices are now available in multiple dimensions. If you use the same 1024x768 folios for 

Android devices, the folios will be letterboxed with black bars. If you want to design for specific devices (such as 

1024x600) or aspect ratios (16:9), you can create different renditions of the same folio. Create renditions by making 

the Magazine Title and Folio Number settings the same but the Dimension export settings different. The viewer offers 

only the rendition that most closely matches the device’s dimensions.

Pagination in HTML articles HTML articles can now be divided into pages more elegantly.

Release 9

eCommerce subscription services in Viewer Publishers can now set up their own subscription model that allows 

customers to subscribe to a magazine or newsletter and receive regular updates of folios. Customers can specify a range 

of folios that remain downloaded on the iPad—especially useful for news magazines.

Desktop Viewer enhancements The Content Viewer for Desktop now supports many previously unsupported 

features such as single-orientation folios and Web View overlays.

Right-edge binding The Content Bundler includes a Binding setting that enables right-to-left reading of articles for 

Asian languages. If Right Edge is selected, the first article appears as the right-most article, and users browse through 

the articles from right to left.

Folio update in viewer An update message now appears in the library if a folio is updated on the fulfillment server. 

Tapping the Update button downloads new or edited mini .folio files.

Dual-orientation videos in single-orientation folios Users can play a full-screen video in landscape orientation even if 

the folio is portrait only.

Data analysis enhancements When using analytic data to track usage, you can distinguish between ads and articles. 

Offline viewer data is also preserved.

Release 7/8

New Overlay Creator panel The Overlay Creator panel in InDesign CS5 replaces the Interactive Overlay Creator 

application. This change means that you now create all interactive overlays natively in InDesign. Use the Overlay 

Creator panel to create overlays and change overlay settings.

Desktop AIR Viewer An AIR-based version of the Viewer is now available for testing the issues (now called “folios”) 

that you create. The Desktop Viewer currently does not support all the features, so use it only as a basic testing tool.

“Issue” -> “Folio” The new term for “issue” is “folio.” 

No ID options Using the same overlay IDs in the horizontal and vertical layout is no longer required in most cases to 

provide continuity when the iPad is rotated. The Bundler uses the source assets and settings to determine related 

overlays.

Grid view in Viewer library The Viewer library now lets you display eight folios at a time in a grid view. You can switch 

between grid view and single view.

Order option The Content Bundler includes a new “Order” column that makes it less likely for you to change the order 

of articles accidentally. Enter a number where you want the article to appear in sequence, and it moves to that place.
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Locked articles while bundling The Content Bundler includes a new “Locked” column that lets you prevent articles 

from being updated when you bundle—especially useful when you just want to test the changes in one or two articles.

Sign Out button in Viewer You no longer need to change your Adobe ID password to display the Sign In button.

3G download Folios can now be downloaded to the iPad via a 3G connection.

Release 6

Flattened articles When an article (called a “stack” at the time) is flattened, each page in the article essentially becomes 

a separate article, allowing customers to scroll horizontally to view the pages of an article. Only the first page of a 

flattened article shows up in the TOC, but all the pages appear in Browse mode and as scrubber thumbnails. You 

cannot flatten a article that is set to smooth scrolling.

Looser folder structure requirements You can now build an entire interactive issue without an OverlayResources 

folder. In previous releases, the source files for overlays had to be in the OverlayResources folder, and the exported 

SWF files had to be in the Links folder of the documents in which they were placed. 

Auto TOC generation The PNG file for the table of contents that was previously required is now optional. If your 

article folder does not have a PNG file, the Content Bundler generates a TOC icon automatically based on the first page 

of the article.

PDF image format In addition to PNG and JPEG, the Bundler can output page images in PDF format. Using the PDF 

image format significantly reduces the file size and offers additional possibilities for future releases such as pinch and 

zoom and searching and selecting text.

HTML articles You can now use either InDesign files or HTML files to create articles in an issue. When you create an 

article using HTML files, you can use the same HTML file for both orientations, or you can create separate HTML files 

for horizontal and vertical orientations.

Specifying HTML thumbnails For InDesign articles, the Viewer automatically generates the thumbnails that appear 

when you drag the scrubber. However, generating thumbnails for HTML articles takes more time, sometimes resulting 

in poorly rendered thumbnails. To improve thumbnail performance in HTML articles, you can allow the Bundler to 

generate thumbnail images based on the first page of each HTML article, or you can manually add image files to the 

HTML article folders.

Viewer UI improvements Users complained that the scroll bar to the right of each article was too thin, so we widened 

the scroll bar. We also improved the appearance and performance of page thumbnails in Browse Mode.

Transparency in scrollable frames Scrollable content frames are now transparent by default. If you don’t want the 

contents of the container frame to appear, apply a fill to the content frame.

Bundler changes In the Content Bundler, the Issue Title metadata text never appeared anywhere in the Viewer, so this 

option was removed, as was the Dimension/Type Settings information. In addition, the Use Cover option was changed 

to Include Cover.

Release 5

Native slideshows and hyperlinks The only way to create interactive slideshows and hyperlinks is through native 

features. Use the Object States panel, the Buttons panel, and the Hyperlinks panel to create interactive objects. Change 

settings by typing the appropriate lines in the Script Label panel. (We hope to include a UI for these settings in the next 

release.)

Enhanced native slideshows You can create navigation buttons that jump to the next or previous slides in the 

slideshow. If you add the “SS_swipeEnabled=yes” line to the Script Label panel when the multi-state object is selected, 

users can swipe to scroll through slides in a slideshow.

Links to specific pages You can now create hyperlinks or buttons that jump to a specific page within an article.
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Simplified “navto” hyperlinks You can specify navtos hyperlinks using either of the target article’s source document 

names, with or without the .html or .indd extension.

Single-orientation articles You can create a portrait-only or landscape-only issue. Simply include only the portrait or 

landscape InDesign documents in the issue folder. The issue maintains its orientation even if the iPad is rotated.

Support of local HTML files for Web View When creating a Web View overlay, you can specify an HTML file from your 

computer. In the previous release, you could only specify a URL on the web to create a Web View overlay.

Scrollable frames Create a view area that lets users scroll vertically or horizontally through the content. For example, 

users can scroll through a list of ingredients.

Back button The Viewer’s navigation bar includes a Back button between the Home and TOC buttons that lets users 

return to the page from where they jumped.

JPEG output in Bundler The Export Options dialog box in Bundler now includes an option for specifying whether to 

export content in PNG or JPEG format.

Improved error handing in Bundler The Bundler provides better feedback during the bundling process.

Release 4

Web View overlay Embed a live web page within a view area that you specify. You can determine whether users can 

interact with the web content and change other settings.

Auto Start options Make an overlay play automatically (or after a specified delay) when the page is turned to. Auto 

Start is available for 360 Viewer, Audio, Video, and Web View overlays.

New 360 Viewer options In addition to the Auto Start option, the 360 Viewer includes new options that give you 

control over playing and pausing, swiping, and looping the images.

navto hyperlinks It’s now much easier to create hyperlinks that jump from one article to another. While creating 

either a native button or hyperlink in InDesign, specify the URL as “navto://<vertical InDesign document name>,” 

such as “navto://WiFi_v” to jump to the WiFi article from either the portrait or landscape orientation.

Simplified native slideshows Multistate objects no longer need to be grouped. The Script Label panel is necessary now 

only to change settings.

Adobe Content Viewer The Adobe Content Viewer lets you upload and download content from an Adobe server, and 

sideload content from your desktop. (Note: sideloading is no longer available.) 

Upload issues to a fulfillment server Adobe created a temporary server site that lets you upload and manage issues. 

While exporting, choose Multiple Files from the Issue submenu, and then specify server upload options. After you 

upload test content to an Adobe server, you can download issues to the Viewer. For this release, the only way to 

download an issue is to log in using the same Adobe ID as the person who uploaded the issue. 

Manage issues in Bundler In the Bundler, you can preview the interface that lets you view and manage uploaded 

issues. For this release, you can add, view, and remove issues uploaded to the Adobe server.

Cover option The first page of the first article can now be used as the cover of the issue in the library for issues you 

upload to the server.

Release 2.5/3

Bug fixes; no new features other than offering the Adobe Content Viewer through the Apple Store.

Release 2

More flexible overlay folder structure In the previous version, each article folder required _h and _v InDesign files 

and a Links folder with the combined assets from the two files, and there was a single OverlayResources folder for the 



20USING DIGITAL PUBLISHING SUITE

Digital Publishing Suite overview

Last updated 11/16/2011

entire issue. While that structure is still valid, you can now have separate folders for the _h and _v files, with each folder 

containing a Links folder and an OverlayResources folder—especially useful for package folders. There are advantages 

to each method.

If you use the method in which the the InDesign files and Links folders appear in separate folders, you must also 

include a separate OverlayResources folder in each article folder rather than the single OverlayResources folder for the 

entire issue.

Regardless of which structure you use, the InDesign files can now include either _h and _v suffixes (for horizontal and 

vertical) or _l and _p suffixes (for landscape and portrait).

Native InDesign interactivity Hyperlinks, buttons, and multi-state objects in InDesign files can now be included in the 

issue without requiring the Overlay Creator. You can use the Script Labels panel to change default settings for these 

objects.

Inline movies Movies can now be played inline rather than full-screen only.

Panorama The Overlay Creator now includes a Panorama option.

Sidecar.xml You can avoid filling out the metadata each time you use the Bundler by creating a CSV file called 

“Info.csv.” Because of problems with certain characters not being displayed correctly, an XML file replaces the CSV file.

Multiple issues You can now add more than one issue to the viewer. Tapping the Home icon takes you back to the 

library of issues rather than to the beginning of the current issue. You can create preview images for the library issues. 

Currently, you can load only eight issues.

Smooth scrolling You can determine whether each article in the issue scrolls continuously or on a page-by-page basis.

Release 1

The first release of the Digital Publishing Suite tools offered the AIR-based Content Bundler and the Interactive 

Overview Creator apps. The first Overlay Creator included Hyperlink, 360 Viewer, Slideshow, Audio, and Video 

overlay types. The Overlay Creator was the only method to create interactive objects.

New feature release notes (all languages)

The Digital Publishing Suite tools are updated frequently. To view a description of the new features in the current set 

of tools, see “What’s new in this release” on page 12.

What's new in this release (English)

Neues in dieser Version (German)

Nouveautés de cette version (French)

What's new in this release (Japanese)

Novità di questa versione (Italian)

Novedades de esta versión (Spanish)

What's new in this release (Korean)

O que há de novo neste lançamento (Portuguese)

What's new in this release (Simplified Chinese)

What's new in this release (Traditional Chinese)

http://help.adobe.com/en_US/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/de_DE/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/fr_FR/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/ja_JP/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/it_IT/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/es_ES/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/ko_KR/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/pt_BR/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/zh_CN/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/zh_TW/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
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Nieuw in deze release (Dutch)

Nyheter i den här versionen (Swedish)

Milyen újdonságokat tartalmaz ez a kiadás? (Hungarian)

Bu sürümdeki yenilikler (Turkish)

Co je nového v této verzi (Czech)

Nyheder i denne version (Danish)

What's new in this release (Russian)

Version uudet ominaisuudet (Finnish)

Nowooci w tym wydaniu (Polish)

What's new in this release (Ukranian)

http://help.adobe.com/nl_NL/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/sv_SE/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/hu_HU/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/tr_TR/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/cs_CZ/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/da_DK/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/ru_RU/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/fi_FI/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/pl_PL/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
http://help.adobe.com/uk_UA/digitalpubsuite/using/WS67cb9e293e2f1f60-21ba9a4512e5e5e0b8d-8000.html
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Chapter 2: Document Design

Use InDesign CS5 to create layouts for mobile devices such as the iPad. Users can rotate mobile devices to view the content 

in either landscape orientation (when the device is held horizontally) or in portrait orientation. Make design decisions 

accordingly. You can design both orientations differently, offering a different page count or content type for each.

Layout design overview

A folio is a publication, such as an issue of a monthly magazine or the contents of a single-issue viewer app. An article 

is a section of a folio. Using InDesign CS5.5 or InDesign CS5, create source documents for your articles. Use the Folio 

Builder panel to create folios and articles. Use the Overlay Creator panel to add interactive objects to your documents.

Related Articles

Designing digital publications

Horizontal and vertical layouts must be in separate InDesign documents, not in the same document. You cannot mix 

and match orientations within folio; the entire folio must be dual, portrait, or landscape.

A dual-orientation article has two layouts—vertical or horizontal. When the user rotates the mobile device, the second 

orientation is displayed. A single-orientation folio is locked into that orientation. For example, if you create articles 

with only vertical InDesign files, that orientation remains in place even if the user rotates the mobile device. However, 

if a folio is portrait-only, full-screen videos can still be played in landscape mode.

To do this: Go here:

Make design decisions “Designing digital publications” on page 22

Use InDesign to create source documents for articles “Creating source documents” on page 26

Add interactive overlays “Interactivity” on page 33

Create folios and articles “Folios and Articles” on page 53

Preview content “Preview folios and articles” on page 65

Share folios with others “Share folios” on page 56
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Landscape and portrait layouts on the iPad

Each document can have multiple pages and assets that differ in the horizontal and vertical orientation. 

Smooth scrolling articles

You can turn on the Smooth Scrolling option for individual articles. Smooth scrolling is useful for long, single-page 

layouts such as a table of contents or a credits article. If smooth scrolling is turned on, create your design accordingly. 

For example, for the iPad, you can create landscape and portrait documents that are 1024x2000 and 768x2000, 

respectively.

In InDesign, use the New Document or Document Setup dialog box to specify the page size. 

A

B
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Page-by-page scrolling and smooth scrolling
A. Horizontal page-by-page scrolling  B. Horizontal smooth scrolling  C. Vertical page-by-page scrolling  D. Vertical smooth scrolling  

Use the Article Properties dialog box to enable Smooth Scrolling. A document with Smooth Scrolling can have only a 

single page.

Note: A bug currently prevents the landscape smooth scrolling layout from being added to an article. For now, the best 

way to create a smooth scrolling article is to create _h and _v files and import the article. See “Import InDesign articles” 

on page 59.

Smooth scrolling works only vertically at this time. To scroll an article horizontally, you can create scrollable content. 

See “Scrollable frame overlays” on page 49.

To adjust the size of the smooth scrolling page, use the Page tool to select the page, and then adjust the page’s height. 

Swiping articles horizontally

If you want one or more articles to flow horizontally only, select the Horizontal Swipe Only option in the Article 

Properties dialog box. Users navigate “flattened articles” by swiping left and right rather than up and down. 
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Flatten articles
A. Unflattened article  B. Flattened article  

Only the first page of a flattened article shows up in the TOC, but all the pages appear in Browse mode and as scrubber 

thumbnails. You cannot flatten an article that is set to Smooth Scrolling.

Using HTML

Here are three ways to take advantage of HTML using DPS tools:

Links to websites Use hyperlinks or buttons to display a website. You can display Websites either in the external 

mobile browser or in an in-app browser in which users click a Close button to return to the folio. See “Hyperlink 

overlays” on page 36.

Web Content overlays Create a Web Content overlay that displays a website or local HTML files within a view area. 

See “Web Content overlays” on page 47.

HTML articles Instead of creating articles with InDesign documents, you can create an HTML folder and import it as 

an article. See “Import HTML articles” on page 59.

Enabling pinch and zoom for articles

If you want users to be able to pinch to zoom in on article content, choose a PDF image format when creating folios 

or articles. Users can pinch and zoom only on PDF pages that do not contain interactive content. Pinch-and-zoom 

PDF articles work only on the iPad viewer.

A B
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Creating source documents

If you’re basing a digital magazine article on an existing print article, creating a new document is usually the easiest 

approach. To repurpose a document, you can change settings in the Document Setup dialog box. Specify a page size 

(such as 1024 x 768 for the iPad) and orientation (portrait or landscape). For dual-orientation folios in which 

customers can view content either horizontally or vertically, create two separate documents for each article—one 

portrait and one landscape.

Do not use facing pages in your document—use only one page per spread.

Guidelines for creating documents

• Turn off facing pages. Do not use the Page tool to change the page size, unless the page is smooth scrolling.

• When creating your design, remember that a 6-pixel scroll bar crops the right edge of the folio layout. Consider 

adding a guide or object on the master page to mark this area.

• To avoid large folio files, use properly sized JPEG and PNG files for interactive assets such as image sequences, pan 

& zoom images, and panoramas. For non-interactive images or slideshow images, you can use any format, 

including PSD, TIFF, AI, and JPEG, and you can scale them down. When you create an article or layout, the non-

interactive objects on each page are compressed and converted into a single PNG, JPEG, or PDF file. Similarly, 

slideshow and button images are compressed into PNG files.

When creating images to be used in interactive overlays, use the Save for Web & Devices option in Photoshop for 

best results.

• When converting portrait and landscape documents, consider using ruler guides with Layout Adjustment for better 

control. See David Blatner’s article Convert Portrait to Landscape with Layout Adjustment.

• Use an InCopy-based feature to share text between portrait and landscape documents. See the InDesign Docs 

article Sharing Text Between Two InDesign Documents.

• To get the best color fidelity, use RGB color images instead of CMYK or LAB.

• Add background colors to a master page. If you want to use different colors for each page in the document, create 

a rectangle shape the size of the page. Apply a fill color, and arrange it to the back of the article. To avoid selection 

problems, lock the background object.

Create horizontal and vertical documents

1 In InDesign CS5, choose File > New > Document.

2 (Optional) For Intent, choose Web.

Choosing Web makes the layout easier to work in for mobile devices. If you’ve already created a document with 

Intent set to Print, you cannot change it to Web. However, you can manually change the settings.

3 For Page Size, specify the dimensions of the device reader.

The iPad uses 1024 x 768 pixels. A 6-pixel area on the right side of the page is cropped on the mobile device. The 

actual design area is 1018 x 768 (or 762 x 1024) pixels.

Similarly, a menu bar covers part (48 pixels) of the design area on Android Viewers. The design area of a 1280 x 

800-pixel document should target a 1232x752-pixel area.

If you want to allow smooth scrolling, you can specify a custom page size (such as 1024 x 3000). See “Smooth 

scrolling articles” on page 23.

http://indesignsecrets.com/convert-portrait-to-landscape-with-layout-adjustment.php
http://blogs.adobe.com/indesigndocs/2010/12/sharing-text-between-two-indesign-documents.html
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4 For Orientation, choose either Portrait or Landscape.

Creating a document for a device reader
A. Set Intent to Web  B. Specify Page Size  C. Choose Portrait or Landscape  

5 For a dual-orientation article, follow the same procedure to create a second document. 

When you save the files, include _v and _h suffixes in the filenames if you want to import articles. For example add 

an _v suffix for the vertical (portrait) document, such as article_v.indd.

6 Design your documents.

Not all InDesign CS5 interactivity features are supported in the digital publishing workflow. For details, see 

“Supported interactivity features” on page 34.

Creating documents for multiple devices

You can create folios and custom viewers for different platforms such as Apple (iPad), Android (Samsung Galaxy Tab 

and Motorola Xoom), and RIM (BlackBerry PlayBook). Devices on these platforms have different dimensions, such as 

1024x768, 1024x600, and 1280x800. You can use a number of different methods to account for the different device 

dimensions, including the following approaches:

• Create a single folio for all devices. Layouts are scaled or letterboxed as needed.

• Create a separate folio renditions for 1024x768 devices and 1024x600 devices. These two sizes yield acceptable 

results on most devices.

• Create separate folio renditions for multiple target mobile devices, such as 1024x768, 1024x600, and 1280x800.

Renditions

Multiple versions of the same folio designed for different devices are called renditions. If you create multiple folio 

renditions, the viewer makes available only the rendition that most closely matches the device’s dimensions. If the 

viewer displays a rendition that does not match the device’s aspect ratio, it scales the folio proportionally. The viewer 

can add either letterboxes (black bars top and bottom) or pillarboxes (black bars on the sides) as needed.

See “Create folio renditions” on page 79.

A

B

C
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Folio renditions
A. 1024x768 folio  B. 1024x600 folio  C. 1024x768 folio letterboxed on 1024x600 device  

Design guidelines for multiple renditions

If you want to repurpose the same document for different devices, note the following guidelines:

• The viewer scales content down but not up. For example, if you view a 1024x768 folio on a smaller device, the 

content is scaled down. If you view that folio on a larger device, the content is letterboxed and pillarboxed but not 

scaled.

• If the viewer needs to scale down content, the performance is not as smooth as it is for content that matches the size 

in a 1:1 ratio. Text and images may appear fuzzy.

• When you add articles to a folio, the aspect ratio of the document’s Page Size setting must match the folio’s Size 

setting. For example, you can add 1024x768 InDesign documents to an 800x600 folio because the aspect ratios are 

4:3. However, you cannot add 1024x768 documents to a1024x600 folio.

• When designing for a BlackBerry PlayBook, use a 1024x600 size. If the PlayBook viewer scales content from a 

different size, the content is pixelated.

• When designing for a device that uses Android 3.0 or later (Honeycomb), such as the 1280x800 Motorola Xoom, 

account for the 48-pixel navigation bar. For example, the navigation bar makes the actual size of the layout on the 

Xoom 1280x752 in landscape and 800x1232 in portrait. If you design using a 1280x800 size, the viewer scales the 

content. Some designers use a 1232x752 design to avoid scaling and minimalize letterboxing.

• iPad displays only folios that are set to 1024x768. To create a folio rendition specifically for non-iPad devices that 

are 1024x768, use a slightly smaller folio size, such as 1024x767.

• To change the InDesign page size, choose File > Document Setup, and then specify new values. If Layout 

Adjustment is not enabled, the page items remain in place, and only the page margins change. If Layout Adjustment 

is enabled, InDesign moves page items and can also resize or scale them, depending on how your document is set 

up. For example, if guides surround an object, the object is scaled when the page size changes. See David Blatner’s 

article Convert Portrait to Landscape with Layout Adjustment.

• Objects on hidden layers do not appear in the exported folio. You can create separate layers for different mobile 

devices and add objects that appear only when that layer is turned on. Before you create an article from a document, 

show and hide the appropriate layers and change the page size as needed.

A B C

http://goo.gl/yLrxm
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Features not supported on other platforms

Some of the features that work on the iPad are not supported in the Android Viewer and other devices. For example, 

panoramas, inline videos, and articles with PDF image format are not supported on the Android platform. Web 

Content overlays and HTML articles are not fully supported on Android.

Structuring folders for imported articles

You can use the Import command in the Folio Builder panel to import articles from the desktop. To import files 

properly, you must follow the structure rules and file naming conventions to determine what is included in a folio.

• To import multiple articles simultaneously, create a folio folder that consists of multiple article folders. When you 

select Import Multiple Articles, point to the folio folder.

• Article folders for dual-orientation folios must contain two InDesign documents. Create one document with an _h 

suffix (such as “article1_h.indd”), and one with a _v suffix (such as “article1_v.indd”).

• Article folders for single-orientation folios must contain only one InDesign file with an _h or _v suffix.

• Each article folder can contain a PNG file for table-of-contents thumbnails. If this file is missing, the toc image is 

generated automatically.

Create folder structure for importing multiple articles

When setting up the folder structure, you can use various methods to organize your article files. Files you link to in 

InDesign do not have to be in the article folder—they can be in any folder where InDesign can find them.

Keep filenames and folder names simple. Avoid using special characters.

Sample structure for files
A. Folio folder  B. Article folders  

If you’re importing multiple articles into a single-orientation folio, make sure that each article folder contains only one 

document. The InDesign files still require an _h or _v extension in single-orientation folios. You cannot combine 

single-orientation and dual-orientation articles in a folio. 

B

A
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Folio with only vertical articles

Create a metadata sidecar file for importing articles

The metadata sidecar.xml file is an optional method for ordering articles and applying metadata when you import the 

files. Use a text editor or an XML editor to create a sidecar.xml file with metadata for each article. Save the sidecar.xml 

file in the root folio folder.
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Valid <isAd> values are “true” and “false.” If the value is “true,” the advertisement does not appear in the table of 

contents.

Valid <smoothScrolling> values include “always,” “portrait,” “landscape,” and “never.” The default is “never,” which 

means scrolling snaps to pages.

Valid <isFlattenedStack> values include “true” and “false.” A true value turns on Horizontal Swipe Only for the article.

Author and Byline are redundant. Use the same entry.

The order of the <entry> sections determines the order of the articles in your project when you create your project or 

when you update it. If an article’s folder name does not appear in the sidecar, it is moved below those that are listed. 

Note: Instead of using a text editor, you can use Microsoft Windows Office Excel. However, make sure that you export 

using the XML Data option rather than the XML Spreadsheet. The XML Data option is not available for the Mac OS 

versions of Excel.

You can copy and paste the following text into a text editor and edit it:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 

<sidecar> 

<entry> 

<folderName>Article One</folderName> 

<articleTitle>title</articleTitle> 

<byline>byline</byline> 

<author>author</author> 

<kicker>kicker</kicker> 

<description>description</description> 

<tags>tag1, tag2</tags> 

<isAd>false</isAd> 

<smoothScrolling>never</smoothScrolling> 

<isFlattenedStack>false</isFlattenedStack>

</entry> 

<entry> 

<folderName>Article Two</folderName> 

<articleTitle>article 2</articleTitle> 

<byline>byline</byline> 

<author>author</author> 

<kicker>kicker</kicker> 

<description>description</description> 

<tags>tag1, tag2</tags> 

<isAd>false</isAd> 

<smoothScrolling>never</smoothScrolling> 

<isFlattenedStack>false</isFlattenedStack>

</entry> 

</sidecar>
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Use sidecar.xml for importing multiple articles

1 Use a text editor or an XML editor to create a sidecar.xml file with metadata for each article.

2 Save the sidecar.xml file in the root folio folder.

3 In the Folio Builder panel, select a folio, and choose Import from the panel menu. In the Import Article dialog box, 

select Import Multiple Articles, specify the folder folder containing the sidecar.xml file, and click OK.

Use sidecar.xml for updating article properties

If you want to use the sidecar.xml file to update your article metadata or change the order of articles, you can use the 

Folio Builder panel to import the sidecar.xml file.

1 Create or edit the sidecar.xml file for your folio. See “Create a metadata sidecar file for importing articles” on 

page 30.

2 Copy or move the sidecar.xml file to its own folder.

3 In the Folio Builder panel, open the folio you want to edit, and choose Import from the panel menu.

4 Select Import Multiple Articles, specify the folder in which the sidecar.xml file is located, and click OK.
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Chapter 3: Interactivity

Overview of interactive overlays

Use the Overlay Creator panel (Window > Extensions > Overlay Creator) to create and edit interactive objects. 

Why are interactive objects called overlays? When you create a folio, all non-interactive items on a page are 

compressed into a single image—PDF, JPG, or PNG, depending on export settings. If you mask or cover interactive 

overlays that you place in the document, the overlays appear on top of the layout in the folio. Only another overlay can 

mask an overlay.

The interactive object appears on top of the non-interactive items.

Ways to create overlays

Different overlays require different methods to create them. 

• For slideshows, hyperlinks, audio and video, pan & zoom images, and scrollable content, create or place the objects 

in the InDesign documents, and use the Overlay Creator panel to edit settings.

• For image sequences, panoramas, and web content overlays, draw a rectangle frame as a placeholder or place an 

image to be used as a poster. Then select it and use the Overlay Creator panel to specify the source and change 

settings.
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When you select a multi-state object, the Overlay Creator panel displays slideshow settings.

Maintaining continuity of interactive objects

When you use the same overlay in both the horizontal and vertical layouts, you want the overlay to maintain its state 

when the user rotates the mobile device. For example, if the slideshow displays the third slide, that third slide should 

remain visible when the user rotates the device.

For most overlays, no action is required to maintain continuity. For slideshows, use the same Object Name in the 

Object States panel for the multi-state objects in the horizontal and vertical layouts. 

More Help topics 

Troubleshoot Interactive Overlays

Supported interactivity features

InDesign CS5 includes many interactivity features for exporting to SWF and PDF. Some but not all of these features 

are supported in the digital publishing workflow.

Supported interactivity features

Multi-State Objects Use MSOs to create slideshows.

Hyperlinks Create URL, Email, and Navto hyperlinks.

Buttons Only the On Release event with one action is supported. 

Supported hyperlink actions include Go To First Page, Go To Last Page, Go To URL, and Go To Page. Supported 

slideshow actions include Go To State, Go To Previous State, and Go To Next State.

Audio Placed mp3 files play. You cannot loop or stream audio at this time.

Video Supported video files play. You cannot loop or stream video at this time.

Additional interactive overlays You can also create web content overlays, image sequences, pan and zoom images, 

panoramas, and scrollable frames.

http://kb2.adobe.com/cps/896/cpsid_89633.html
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Interactivity features not supported

Animation Animated objects are flattened when the article is created. One workaround is to export an animated 

InDesign document in FLA format and use the Wallaby utility to create an HTML5 file. You can then use this HTML5 

file as a Web Content overlay. For details, see Animate Headlines by Johannes Henseler and From InDesign to HTML5 

via Flash by James Fritz.

Certain hyperlinks Text Anchor and Shared Destination hyperlinks are not supported.

Certain button actions Go To Destination, Go To Next Page, Go To Previous Page, Show/Hide Buttons, Sound, and 

Video button actions are not supported. Multiple actions are not supported. On Click and On Rollover events are not 

supported.

Other features not supported Bookmarks, cross-references, and page transitions are not supported.

Best practices for creating overlays

Source files

• The Folio Builder does not compress the source assets of panoramas, image sequences, image pans, or audio skins. 

To minimize file size, use JPEG images with medium compression (50-80% range) for the source files. Use PNG 

images only if the images include transparency. Compressing overlay images and video can significantly reduce the 

size of the folio.

• For best results, create the source files for panoramas, 360 views, image pans, or audio controllers using the exact 

dimensions in pixels and 72 dpi.

In Photoshop and Illustrator, the File > Save for Web & Devices command is especially useful for saving image files 

with specific pixel dimensions.

• For large text in overlays, use a PNG or JPG image with medium-high compression. For small text or detailed icons, 

use PNG images.

Setup

• For panoramas, image sequences, audio skins, and local web content overlays, create a separate folder for overlay 

files. These source files are necessary for bundling.

• Avoid running interactive objects into the bleed area. Keep interactive objects within the page size area.

Tips and guidelines

• When working with overlays, choose Window > Workspace > Interactive to make interactive panels more 

accessible.

• Use a consistent method to let users know which objects are interactive. For example, you can create poster images 

that use icons to indicate different types of overlays.

• When you place overlay files in InDesign, the frame size determines where you tap to activate the interactive 

content. If you change the size of the overlay, use a Fitting option to fit content to frame.

• In some cases, you want an image to appear over the overlay, such as a mask for a video. To do this, create a 

“dummy” overlay. For examples of this trick, see examples in the Digital Publishing Suite Tips app by Bob 

Bringhurst or Creating Super Overlays by Johannes Henseler.

More Help topics 

Troubleshoot Interactive Overlays

http://goo.gl/B9mBR
http://goo.gl/D50Tp
http://goo.gl/D50Tp
http://digitalpublishing.tumblr.com/post/10161880827/creating-super-overlays-that-overlay-other
http://kb2.adobe.com/cps/896/cpsid_89633.html
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Hyperlink overlays

You can use the Hyperlinks panel or the Buttons panel to create links that jump to websites, other articles, and more. 

Not all button actions and hyperlink types are supported in folios.

At this time, you can add hyperlinks in scrollable frames, but hyperlinks in slideshows or other interactive overlays are 

not yet supported.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Create links using the Buttons panel

Use the Buttons panel to create links to the first or last page of a document or to a different article.

1 In InDesign, create the object to be used as the button.

For example, if you want the button to jump to a website, create a text frame or place an image.

2 Open the Buttons panel (Window > Interactive > Buttons), select the object, and click the Convert Object To 

Button icon.

3 For Event, choose On Release.

On Release is the only supported button event. 

4 Click the plus sign next to Action and select a supported action.

Supported button actions
A. Supported actions for hyperlink buttons  B. Supported actions for slideshow buttons  

Supported hyperlink actions include Go To First Page, Go To Last Page, Go To URL, and Go To Page. Go To Next 

State, Go To Previous State, and Go To State actions are supported for slideshows.

Do not use the Go To Destination action to jump to a different article. Instead, use the Go To URL action with a 

“navto” format.

A

B

A

A
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All other actions—including Go To Next Page and Go To Previous Page—are currently not supported. Buttons can 

have only one action.

Create links using the Hyperlinks panel

In InDesign, you can use the Hyperlinks panel to add hyperlinks. Creating hyperlinks is especially useful for jumping 

to a web page, to a different article, and to a different page.

Hyperlinks are especially useful for text. If you want a frame to be a hyperlink, consider using the Buttons panel instead 

of the Hyperlinks panel. Buttons are more versatile and less likely to break.

1 Select the frame or text that you want to use as a hyperlink.

2 Open the Hyperlinks panel (Window > Interactive > Hyperlinks).

3 In the Hyperlinks panel, choose New Hyperlink from the panel menu.

4 Deselect Shared Destination.

Shared Destination lets you name and reuse hyperlinks, but it’s better to avoid using this option in the DPS 

workflow.

5 In the Link To menu, specify any of the following options, and then click OK:

URL Tapping a URL hyperlink displays a web page (http://), an App Store application (itms://), an Android Market 

application (market://), or a different article (navto://).

Example: http://www.adobe.com

When linking to websites, type the entire URL, including “http://.”

Note: When linking to an iTunes URL, deselect Open in Folio in the Overlay Creator panel. Otherwise, a “Cannot 

Open Page” error message appears when the hyperlink is tapped. Similarly, if you use an itms:// or market:// format 

to link to a store app, turn off Open In Folio. 

A navto:// hyperlink jumps to a different article or a different page in that article. Type navto:// followed by the 

article name as it appears in the Folio Builder panel. Use the Article Name value, not the article’s Title value. If you 

want to include a page number, add # followed by a number. But keep in mind that the first page is 0, so adding #2 

jumps to page 3.

Example: navto://newsarticle

Example: navto://newsarticle#2 (jumps to page 3)

Email Tapping an Email hyperlink launches the Mail app with the To field filled in. 

Page Tapping a Page hyperlink jumps to a different page within the article. Do not use this option for jumping to 

a different article.

The Text Anchor hyperlink is not supported.

6 To change hyperlink settings, select the hyperlink objects, and then specify these settings in the Overlay Creator 

panel (Window > Extensions > Overlay Creator):

Open In Folio Display the content in a web view within the Viewer. Deselect this option when linking to iTunes, 

itms://, or market:// URLs.

Open In Device Browser Display the content outside the Viewer in the mobile device browser, such as mobile Safari 

on the iPad. Select Ask First if you want a prompt to appear when users tap the link. This option is disabled if Open 

In Folio is selected.
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Note: The Overlay Creator panel settings are not available for text hyperlinks. You cannot change settings for text 

hyperlinks; they are set to Open In Folio by default.

For additional details on creating hyperlinks, see Create hyperlinks in InDesign CS5 Help.

Create links to other articles

Folio articles are stored on a server, so any link that specifies a path to an InDesign file is broken when previewed. Use 

the “navto” format to link to other articles.

When creating either a button or hyperlink, you can replace “http://” with “navto://” in the URL field. Then specify 

the target article name as it appears in the Folio Builder panel. Use the Article Name value, not the article’s Title value. 

Valid navto formats include navto://[articlename] and navto://[articlename]#n. Adding #n specifies a page 

number. The first page of a document is 0, so specifying #2 jumps to page 3.

Jumping to page 3 of a different article

Navto examples:

navto://biking

navto://biking#2 (jumps to page 3 of biking article)

Note: If you used a previous version of the tools to create a navto link using a folder name or article name that differs 

from the target article name, your links are broken. To fix the navto links, you can either rename the article (the name, 

not the title) or edit the navto links to point to the article name as it appears in the Folio Creator panel.

Create navto hyperlinks for HTML articles

When you create a URL-based hyperlink or button, you can use the “navto://” URL to jump to a different article. Navto 

is especially useful for jumping to HTML articles. You cannot use navto hyperlinks in Web Content overlays.

Jump to HTML article Type navto:// followed by the HTML article name (not the article title). 

Example: navto://newsarticle

Jump to anchor in HTML article You cannot jump to a specific page within an HTML article, but you can jump to an 

anchor by typing navto://<foldername>#<anchor name>.

http://help.adobe.com/en_US/indesign/cs/using/WS2162F434-F475-4b73-950B-B23DA7744492.html
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Example: navto://newsarticle#part4

Note: To define an anchor in an HTML file, open the HTML file in a text editor. Navigate to the text that you want to 

act as an anchor, and enclose the text with an anchor tag, such as “<a name="part4">This is Part 4 of the Article</a>.”

Jump to InDesign article from HTML article Use the navto format to create a hyperlink from an HTML article to an 

InDesign article. Example:

<a href="navto://newsarticle">See the News Article</a>

You can also navigate to pages within an InDesign article by adding the page number after the document name. The 

first page of the document is 0, and the second page is 1, and so on. Example:

<a href="navto://Cycling#3">Go to Page 4 of the Cycling Article</a>

Jump from HTML to HTML Use the navto format to jump from one HTML article to another using the folder name. 

Example:

<a href="navto://newsarticle">See the News Article</a>

Display a local HTML file in an in-app browser

You can create a hyperlink or button that displays a local HTML file or asset in the Viewer’s in-app browser.

1 Add a folder containing the local HTML file to the HTMLResources folder.

Make sure that the HTMLResources folder is included in the folio. The HTMLResources folder can be added only 

from the Folio Producer on the web.

2 Use any of the following methods to display the HTML file in the in-app browser:

InDesign source document In the URL field of either a hyperlink or button, enter the path without http://, navto://, 

or any other prefix. Example:

HTMLResources/Cartoons/train1.html

HTML article From an HTML article, specify the location. Example:

<a href="../HTMLResources/Cartoons/train1">See Train Cartoon Gallery</a>

Create links to external apps and services

You can create a link that sends an email message (mailto:) or a text message (SMS). You can also create links that open 

the YouTube app or an iTunes song or album. To learn more about the required formats to use for the iPad, see the 

Apple URL Scheme Reference.

Control the appearance of hyperlinks and slideshows in the viewer

When users browse through a folio on the mobile device, the horizontal and vertical pages they see are rasterized 

images of each InDesign page. The page thumbnails that appear when the user taps the Browse button or uses the 

scrubber at the bottom of the mobile device are also rasterized images. You can control the appearance of the 

hyperlinks and slideshows in these rasterized images.

To control the appearance of hyperlinks and slideshows, create a config text file and save it in the InDesign application 

folder. This file, called NativeOverlays.config, lets you include or suppress native hyperlinks and slideshows.

1 Open a text editor.

2 Add one or more of the following lines.

http://developer.apple.com/library/ios/#featuredarticles/iPhoneURLScheme_Reference/Introduction/Introduction.html
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(“Asset” refers to the main pages, “Thumbnails” refers to the Browse icon images, and “Scrubbers” refers to images 

that appear when the user drags the scrubber.)

SuppressOverlayTypesForAssets: <slideshow, hyperlink>

SuppressOverlayTypesForThumbnails: <slideshow, hyperlink>

SuppressOverlayTypesForScrubbers: <slideshow, hyperlink>

ResetHyperlinksToTopState: <ThumbnailPass, ScrubberPass, AssetPass, All>

ResetHyperlinksToTopState means that any button with a Go to URL action displays the [Normal] state instead of 

the [Click] state.

ResetSlideshowsToTopState: < ThumbnailPass, ScrubberPass, AssetPass, All>

ResetSlideshowsToTopState resets the multi-state object to the top state of the multi-state object in the InDesign 

document. If you suppress overlays, reset settings do not apply.

If ResetHyperlinksToTopState and ResetSlideshowsToTopState are not specified, the default behavior is to reset to 

top states for both slideshows and hyperlinks.

Example:

SuppressOverlayTypesForAssets: slideshow  
SuppressOverlayTypesForThumbnails: hyperlink  
SuppressOverlayTypesForScrubbers: slideshow, -hyperlink  
ResetHyperlinksToTopState: All  
ResetSlideshowsToTopState: ThumbnailPass, ScrubberPass

If you type a minus sign before the overlay type, that overlay type is not suppressed.

3 Save the file with the name, NativeOverlays.config.

4 Move the NativeOverlays.config file to the InDesign application folder using one of these methods:

Windows Move the config file to the same level as the InDesign.exe file.

Mac OS Select the Adobe InDesign CS5 application icon, right-click, and choose Show Package Contents. Move the 

config file to the Content > MacOS folder.

Slideshow overlays

Use the Object States panel to create a set of images for a slideshow. Each state, or slide, can contain multiple objects. 

For example, if you want a different text frame to appear with each image, combine the image and text frame on the 

same state. At this time, interactive objects on a state lose their interactivity in folios. 
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Create a slideshow using the Object States panel

Slideshow images are converted into PNG images in the folio.

Currently, you cannot make a slideshow play in full-screen mode.

1 In InDesign, use the Object States panel (Window > Interactive > Object States) to create a slideshow. (For details, 

see “Create a multi-state object slide show” in InDesign CS5 Help.)

When you create a multi-state object, you insert images, align them in an article, and convert the article to a multi-

state object. 

2 In the Object States panel, specify an object name.

When your multi-state objects in the horizontal and vertical documents have the same object name, the slideshow 

maintains continuity when the iPad is rotated.

Note: To avoid bundling errors, do not include punctuation or extended characters in the object name or object state name.

3 Create navigation buttons that browse through the states in the multi-state object.

Use the Go To State action to refer to a specific slide. Use the Go To Next State and Go To Previous State actions 

to navigate through slides.

The Sample Buttons panel in InDesign includes a library of navigation buttons. If you use these sample buttons, 

delete the existing action and replace with a Go To Next State or Go To Previous State action.

4 If you want the button appearance to change when it’s tapped, click [Click] under Appearance, and change its 

appearance.

If a button uses the Go To State action, the [Click] state appears when the specificed state is selected. For example, 

the [Normal] state button can have a black frame, and the [Click] state can have a red frame. The red frame appears 

when the button is tapped on the iPad. (The [Rollover] state is not supported on mobile devices.)

5 To change slideshow settings, select the multi-state object, and specify the following settings in the Overlay Creator 

panel (Window > Extensions > Overlay Creator):

Auto Play When selected, the slideshow begins playing when users turn to the page.

Tap to Play/Pause When selected, this setting lets users tap to play and pause an auto-running slideshow. Double-

tapping resets the slideshow.

Delay If Auto Play is selected, you can specify the time that elapses between loading the page and the start of the 

slideshow. Specify a value from 0 to 60 seconds.

http://help.adobe.com/en_US/indesign/cs/using/WS14840753-3931-4e67-AEE6-3F2C2016CB4C.html#WS67cb9e293e2f1f60-27b6480d1255231f6c3-8000
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Interval If Auto Play or Tap To Play/Pause is selected, the Interval value determines the duration of display for each 

slide. 

Play _ Time If either Auto Play or Tap To Play/Pause is selected, you can specify the number of times the slideshow 

plays. This option is dimmed if Loop is selected.

Loop If either Auto Play or Tap To Play/Pause is selected, select Loop to play the slideshow continuously until the 

user double-taps the slideshow or turns the page. 

Stop At Last Image If either Auto Play or Tap To Play/Pause is selected, select Stop At Last Image to stop at the last 

image of the slideshow instead of the first. 

Cross Fade When selected, this setting provides a fade transition to the next slide. The value is 0.5 seconds by 

default. You can specify a value between 0.125 seconds and 60 seconds. This value applies to both auto-running and 

manually advanced slideshows.

Swipe to Change Image When enabled, this setting lets the user swipe to move from slide to slide. 

Stop at First/Last Image This setting determines whether the slideshow stops playing or continues when the last 

slide is reached going forward or the first slide is reached going backward. This option affects only swiping.

Hide Before Playing If selected, the slideshow remains hidden until the user taps a button to display a slide.

Play In Reverse When enabled, the slideshow plays the images in reverse order.

When you copy the multi-state object to a different document, the object is renamed. For example, “sea slugs” 

becomes “sea slugs2.” To maintain continuity when the device is rotated, make sure that the object names in the 

horizontal and vertical documents are identical.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Image Sequence overlays

The Image Sequence (previously called “360 Viewer”) overlay progresses through a series of images. It allows you to 

create effects such as rotating an object 360° on the mobile device.

• Use png or jpg image files that have the same root name with ascending suffixes, such as Tower001.jpg, 

Tower002.jpg, and so on. Make your image dimensions correspond exactly to the display area on the mobile device, 

such as 500 x 400 pixels in 72 dpi.

• For smooth 360° rotation, use at least 30 images. Using too many images increases the file size unnecessarily. To 

reduce file size, use JPEG images compressed in the 50-80% range. Use PNG files only if you want to include 

transparency.

Create a set of images to be used for the image sequence
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You can use a number of different methods to create images of a 3D object. One method is to use Adobe Photoshop® 

Extended to export an image sequence of a 3D object. You can use Adobe Flash® Professional or Adobe After Effects® 

to export frames from an animation or video. You can also use a 3D authoring application to generate images of a 3D 

model.

1 Create the source assets for the image sequence object, and place them in a folder.

2 Do one of the following:

• Using the Rectangle tool or Rectangle Frame tool, drag to create a placeholder frame.

• Place an image that acts as a poster for the image sequence. To avoid skewing, use the same dimensions for the 

poster image that you use for the image sequence images. (If you use a poster image, double-tapping the image 

in the viewer hides the image sequence and displays the poster.)

3 Select the placeholder object, open the Overlay Creator panel (Window > Extensions > Overlay Creator), and select 

Image Sequence.

4 In the Overlay Creator panel, click the Load Images folder icon, locate the folder containing the images, and click Open.

5 If necessary, scale the frame and its contents to fit in your layout.

6 Specify the following settings in the Overlay Creator panel:

Show First Image Initially If this option is selected, the first image is used as the poster. If Play In Reverse is selected, 

the last image is used as the poster.

Auto Play If this option is selected, the image sequence begins playing when users turn the page.

Tap To Play/Pause When selected, this setting lets users tap to play and pause the image sequence. Double-tapping 

resets the object.

Delay If Auto Play is selected, you can specify the time that elapses between loading the page and the start of the 

image sequence. Specify a value from 0 to 60 seconds.

Speed Change the speed of the object’s progression in frames per second. The minimum value is 1 (1 frame per 

second) and the maximum value is 30.

Play _ Time If either Auto Play or Tap To Play/Pause is selected, you can specify the number of times the image 

sequence plays. This option is dimmed if Loop is selected.

Loop If either Play On Page Load or Tap To Play/Pause is selected, you can select Loop to play the image sequence 

continuously. Double-tapping the slideshow or turning the page stops the sequence. 

Stop At Last Image If either Auto Play or Tap To Play/Pause is selected, select Stop At Last Image to stop at the last 

image of the sequence instead of the first. 

Swipe To Change Image When enabled, this setting lets the user swipe to move forward or backward through the 

images. 

If Swipe To Change Image is not selected, select either Auto Play or Tap to Play/Pause to make the image sequence 

interactive.

Stop at First/Last Image You can determine whether the object stops playing or continues when the last image is 

reached going forward or the first image is reached going backward. This option affects only swiping.

Play In Reverse When enabled, the image sequence plays the images in reverse order.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35
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Panorama overlays

The Panorama overlay provides the illusion of viewing an image from the inside out. For example, you can create a 

Panorama effect that lets users see inside an airplane’s cockpit. They can rotate the view 360° and zoom in on the 

instrument panels. 

The key to creating a panorama is getting the necessary images. To create a Panorama effect, the Overlay Creator 

requires a set of six images, which represent the six inner sides of a cube. If you begin with a full panorama image, 

convert it to six cube images based on that image.

Creating a panorama
A. Original panorama image  B. Panorama image converted to inner six sides of cube  C. Panorama on iPad  

If you begin with a horizontal cross image, you can use Photoshop or a screen capture utility to create the six required 

images.

A B

C
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To divide a panoramic cross image into separate images, follow this pattern.

1 Create the source assets for the panorama, and place them in a folder.

For best results, use JPEG images saved in 72 dpi. High-resolution images allow customers to zoom in more clearly 

but require a larger file.

2 Do one of the following:

• Using the Rectangle tool or Rectangle Frame tool, drag to create a placeholder frame.

• Place an image that acts as a poster for the panorama.

3 Select the placeholder object, open the Overlay Creator panel (Window > Extensions > Overlay Creator), and select 

Panorama.

4 In the Overlay Creator panel, click the Assets folder icon, locate the folder containing the six images, and click Open.

5 If necessary, scale the frame and its contents to fit in your layout.

6 Specify the following settings in the Overlay Creator panel:

Use First Image For Poster Selecting this option uses the first panorama image as the poster. Select this image if you 

have not created a different image to be used as the poster.

Initial Zoom Specify a value to determine the magnification of the initial image. Use a value between the Min/Max 

field of view settings, which are 30 and 80 by default. .

Vertical/Horizontal Specify values to determine which area of the panorama is initially displayed. For Vertical, 

specify a value between -90 (tilted all the way up) and 90 (tilted all the way down). For Horizontal, specify a value 

between -180 (rotated all the way left) and 180 (rotated all the way right).

Field Of View If you don’t want users to zoom in or out past a certain point, specify Min and Max values.

Limit Vertical Pan If you want to allow tilting only two-thirds toward the top, select Limit Vertical Pan and specify 

-60. Specify 60 to allow tilting only two-thirds toward the bottom. Use a small value such as 1 to prevent vertical 

panning.

Limit Horizontal Pan If you want to allow panning only two-thirds toward the left and right, select Limit Horizontal 

Pan and specify -120 for left and 120 for right.

Note: To see the effect of the different panorama settings, change the settings and click Preview.

5

4 2 3

6

1
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More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Audio & Video overlays

Supported video and audio files you place in InDesign play when tapped in the Viewer. For video files, use a format 

that is compatible with Apple iTunes, such as an MP4 file with h.264 encoding. For audio files, use MP3 files.

Currently, you cannot specify a URL to stream audio or video from the web using the Audio & Video overlay. 

However, you can stream media using a Web Content overlay or an HTML article.

Video and audio files

Audio

The mp3 files that you place in InDesign play when tapped in the Viewer. To simulate a controller skin, you can create 

a simple effect that toggles between a play and pause button. Or, you can create a more advanced effect that displays 

audio progression.

Video

You can play video inline or in full-screen mode. For best results with inline videos, create a movie in the appropriate 

dimensions, such as 400 x 300 pixels, and create a separate poster image using those same dimensions. Set full-screen 

movies to 1024 pixels wide for the iPad. For a good balance between file size and quality, some publishers recommend 

10-12 MB per minute of film.

You can specify a poster image from one of the movie frames. However, the recommended method is to create a poster 

image that indicates the object is interactive.

1 Choose File > Place, and place the video or audio file in your document.

2 Select the placed object, open the Media panel (Window > Interactive > Media), and specify a poster.
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For a video file, you can choose an image or specify a frame from the video. For best results, choose an image that 

indicates the page item is interactive.

3 With the media frame selected, specify any of the following options in the Overlay Creator panel.

Audio Controller Files Click the folder icon, and specify the folder containing the play and pause buttons for audio 

files.

To display a controller skin with Play and Pause buttons while the audio clip is playing, create a set of .png files in 

a folder. These images each must have either a _pause or _play suffix. You can create a single pair of _play and 

_pause buttons, or you can create multiple _play and _pause buttons that represent progressive states of a status bar.

AudioAsset001_play.png  
AudioAsset002_play.png  
AudioAsset003_play.png  
AudioAsset004_play.png  
AudioAsset005_play.png  
AudioAsset001_pause.png  
AudioAsset002_pause.png  
AudioAsset003_pause.png  
AudioAsset004_pause.png  
AudioAsset005_pause.png

In this example, when your audio is played half way, the AudioAsset003_play.png button is displayed. When 

tapped to pause, the AudioAsset003_pause button is displayed.

Show First Image Initially (InDesign CS5.5 only) If this option is selected, the audio frame displays the first 

_play.png file in the specified audio controller assets folder, and the frame resizes appropriately. 

In InDesign CS5, specify the poster image, and then manually resize the frame and the poster image.

Auto Play Select this option to play the audio or video file when the page is loaded on the mobile device. You can 

also specify the number of seconds to delay.

Play Full Screen If this option is selected, the video plays in full-screen mode. If this option is not selected, the video 

plays within its bounding area.

Tap To View Controller If this option is selected, tapping the video while it’s playing displays a controller bar with 

pause and play controls. If this option is not selected, tapping the video pauses and restarts.

When the user initiates the audio, it is played immediately while allowing the user to continue to read the content in 

the current article. Navigating to another article stops and resets the audio. However, turning the page does not stop 

the audio.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Web Content overlays

The Web Content (previously called “Web View”) overlay lets you display a web page within a view area. Users can 

see the web page content in the view area without having to display a separate in-app browser. You can specify a web 

URL or a local HTML file.

If you specify a local HTML file, make sure that the .html file and associated files and folders appear in the same folder. 
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For any URL that gets redirected to a mobile URL automatically, specify the mobile URL (such as 

http://mobile.twitter.com/), not the original URL (such as http://twitter.com).

1 Do one of the following:

• Using the Rectangle tool or Rectangle Frame tool, drag to create the frame that displays the web content.

• Place an image that acts as a poster for the web content.

2 Select the frame, and select Web Content in the Overlay Creator panel.

3 Do one of the following:

• To specify a URL, type or paste the URL in the Assets field. Type the entire URL, including “http://.”

• To use local HTML files, click the folder icon and specify the local HTML file. The HTML file (such as 

index.html) should appear in a folder that includes any images or scripts used in the HTML file.

4 Specify any of the following options:

Auto Play Select this option to load the web page when the page is loaded on the mobile device. You can also specify 

the number of seconds to delay.

Transparent Background If this option is selected, the transparent background in a web page is preserved. If this 

option is deselected, the web content background is used.

Allow User Interaction If this option is selected, users can interact with the web page. For example, they can tap a 

hyperlink to jump to a different web page.

Scale Content To Fit If this option is selected, the web page is scaled to fit within the size specified in the overlay file. 

If this option is not selected, the web page is displayed at the same size it would appear in the device’s browser, and 

the HTML page can be cropped.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Pan and Zoom overlays

You can display a large image in a small area and allow the user to pan and zoom the image within that area. Note the 

following:

• Currently, the view area must be rectangular.

• For best results, use JPEG images. Make sure that the image has the exact dimensions you want to use. For example, 

to pan a 1024-by-1024 pixel image within a 200-by-200 pixel view area, create a 1024-by-1024 image in 72 dpi.

• For best results, avoid using an image larger than 1024-by-1024 pixels. Large images increase the file size and can 

cause memory problems on mobile devices. The maximum width and height size is 2000 pixels in 72 dpi.

• Currently, the Pan and Zoom feature is not designed to work with transparent images. When a page with an image 

pan is loaded, the poster appears, and the actual overlay is invisible until it is tapped. When users double-tap the 

overlay, it disappears and the poster is displayed. If the image pan contains transparency, the poster shows through 

and appears to be a duplicate image.

1 Place a JPEG or PNG image.
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2 Using the Selection tool, drag the a selection handle to crop the frame without resizing the image. Make the frame 

the size of the view area. Position the image within the frame to determine the initial view area.

Make sure that the container frame is smaller than the image. If the width or height of the frame and image are the 

same size, the object is treated as scrollable content.

To add a poster to the Pan and Zoom overlay, create a frame the same dimensions as the image pan, and place it 

over the Pan and Zoom overlay. When the user taps the poster, the image pan is activated and hides the poster. 

When the user double-taps the image pan, the poster is displayed again.

3 To change the initial view magnification, use the Direct Selection tool to select the image (not the frame), and scale 

the image.

You can change the image size to 100% or lower. The maximum scale is 100%.

4 Select the image frame, and open the Overlay Creator panel. Click the Pan & Zoom tab, and then click the Pan & 

Zoom option.

The Pan Only option is useful for creating a frame in which users can scroll the content vertically or horizontally. If 

you select Pan Only, the upper left corner of the content must appear in the upper left corner of the frame. See 

“Scrollable frame overlays” on page 49.

If you select Pan & Zoom or Pan Only, the object is converted to an overlay. Click Reset to convert it back to an object.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Scrollable frame overlays

You can create a scrollable frame that lets users scroll to view more content. For example, you can create a cooking 

page with a list of ingredients and a set of instructions. Rather than turning to the next page to see the full set of 

ingredients or instructions, users can swipe to scroll.

The initial view for scrollable content is the upper-left corner of the container frame. Currently, you cannot change the 

initial view.

You can add all interactive overlays except slideshows to scrollable frames. For interactive objects to work, use the Pan 

Only method to create the scrollable frame, not the layers method.

More Help topics 

“Supported interactivity features” on page 34

“Best practices for creating overlays” on page 35

Create simple scrollable images using Pan Only

1 Select an image.

2 Drag the bottom or right selection handle to crop the frame.

3 In the Overlay Creator panel, select Pan Only.
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When users view the folio, they can either drag vertically or horizontally to scroll the larger image within the smaller 

frame.

Create scrollable frames using Pan Only

You can create a scrollable frame by cutting a frame or group of objects and pasting it into a smaller container frame.

1 To make a frame that scrolls vertically, create a content frame and a container frame.

• Make sure that the content frame and the container frame have the same width.

• The content frame can be a text frame, an image, or a group of objects. 

• You can include any interactive object except a slideshow in your content frame. Either add the interactive 

objects to the text frame as anchored objects or group interactive objects with other objects.

• For best results, do not apply a stroke to the container frame. If you want the container frame to have a border, 

the safest approach is to create a separate frame with a stroke. If the container frame includes a stroke that’s 

larger than 1 pixel, the text frame scrolls both horizontally and vertically within the frame unless the stroke is 

aligned to the inside

2 Align the top of the content frame with the top of the container frame.

If you don’t align the top of the frames before cutting, pasting the text frame into the container frame displays the 

middle of the container frame as the initial view in your layout, and unexpected results may occur. In the resulting 

folio, the top left of the content frame aligns with the top left of the container frame regardless of the initial view. 

3 Select the content frame, and choose Edit > Cut.

4 Select the container frame, and choose Edit > Paste Into.

5 With the container frame still selected, choose Pan Only in the Overlay Creator panel.

Create scrollable frames using the Layers panel

When you create scrollable frames using the Layers panel, you add the content frame to one layer and the container 

frame to a different layer named “Scrollable Content.”

To include hyperlinks in the scrollable frame, use the Pan Only method to create scrollable content. Hyperlinks are not 

supported in a scrollable frame created with the Layers panel.

1 In the Layers panel, create a layer called Scrollable Content.

The layer name is case-sensitive; type the layer name accurately.

2 Create two objects—a container frame and a content frame that contains the scrollable content.

For best results, make the width of the container frame and the content frame identical for vertical scrolling. Make 

sure that the content frame does not include overset text.

The content frame has a transparent background by default. Apply a fill to the content frame if you do not want the 

page items behind it to show. For example, if your container frame includes a graphic, that graphic appears behind 

the scrollable content unless you apply a fill to the content frame. 
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Scrollable content
A. Content frame added to Scrollable Content layer  B. Container frame with identical name on different layer  C. Layers panel  
D. Scrollable frames on iPad  

To display objects in the scrollable frame—such as a text frame, an image, and a caption—arrange these objects 

vertically and group them.

Note: To keep the scrollable content from interfering with your layout, you can place it on the pasteboard or on a 

hidden layer. However, if the scrollable content is placed entirely on the pasteboard, linked objects are dropped when 

you package the files. To include the linked files, make part of the frame touch the document page. You can change the 

size of the pasteboard in InDesign preferences.

3 Move the content frame to the Scrollable Content layer.

Move only content frames to the Scrollable Content layer. Do not move container frames—or any other object—to 

the Scrollable Content layer.

4 In the Layers panel, rename both the container frame and the content frame so that they have the same name, such 

as “Ingredients.”

A B C

D
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To rename an object in the Layers panel, click the arrow to the left of the layer to expand it. Click the object, pause, 

and then click again. Type to replace the selection.

If the scrollable content is a group, rename the group. The group and an object in the group can have the same name.

When you copy and paste the objects from one document to another, make sure that Paste Remembers Layers is 

selected in the Layers panel menu. That way, you don’t have to re-create the Scrollable Content layer.



53

Last updated 11/16/2011

Chapter 4: Folios and Articles

Create folios

A folio includes one or more digital publishing articles. A folio appears as an issue in the library of either the Adobe 

Content Viewer or a custom multi-folio viewer. If you create a custom single-folio viewer, the folio includes the 

contents of that viewer app.

Some folios are not intended for publication. For example, you can create a folio that contains a mix of horizontal-only 

and vertical-only articles intended for different magazines. However, if you try to publish or preview that folio, an error 

will occur.

Folio Builder panel overview

Use the Folio Builder panel (Window > Extensions > Folio Builder) to create folios and add articles. The Folio Builder 

panel displays the folios to which you have access. The Folio Builder panel includes three views: folio view, article view, 

and layout view. To navigate, do any of the following actions:

• Double-click a folio to display the articles in that folio.

• Double-click an article to display the article’s layouts (portrait and landscape).

• Click the arrow icon  in the upper left corner of the panel to return to Folio view.

Folio Builder panel
A. Folio view  B. Articles view  C. Layout view  

Filter displayed folios

To determine which folios are displayed, choose All, Active, Private, or Shared from the drop-down menu in Folio 

view. Active folios are marked as Active in the web client and show a color badge in the upper left corner. Private folios 

are folios that are not being shared.

A B C
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Sort folios

Choose an option from the Sort drop-down menu in Folio view to determine the sort order of folios in the Folio 

Builder panel. Select Reverse List to reverse the order for any folio selected.

Sign in to Folio Builder panel

Use a verified Adobe ID to sign in to the Folio Builder panel.

1 Make sure that your computer is connected to the internet.

2 In the Folio Builder panel (Window > Extensions > Folio Builder), click Sign In, and then sign in using a verified 

Adobe ID.

3 If you do not have a verified Adobe ID, go to https://digitalpublishing.acrobat.com/ and click Create Account. Sign 

up for an account using a valid email address. Adobe will send you a verification message. Open that message and 

verify it. Then use that Adobe ID to sign in to the Folio Builder panel. See “Using Adobe IDs for digital publishing” 

on page 5.

Create a folio

A folio is a collection of articles. Anyone with InDesign CS5 or later can create folios. 

When you sign in and create a folio, a workspace is created on a web server. The content of any article you add to the 

folio is uploaded to that workspace.

1 Choose Window > Extensions > Folio Builder to open the Folio Builder panel.

2 If you have not already signed in, click Sign In, and sign in using a verified Adobe ID.

If you do not sign in to the Folio Builder panel, you can create an offline folio. You can then upload that offline folio 

after you sign in.

3 Click New to create a new folio.

4 Specify the following settings, and click OK.

Folio Name Specify the folio name. The folio name is different from the Publication Name that appears in the 

viewer.

Size Specify the dimensions of the target device, such as 1024x768 for the iPad or 1024x600 for the Samsung Galaxy 

Tab. You can also specify a custom size, such as 1232x752 for the Motorola Xoom.

When you specify the folio size for the target device, take into account whether the device displays a navigation bar. 

For example, a 48-pixel navigation bar appears in Xoom devices, causing the viewer to scale a 1280x800 folio. 

Instead, create a 1232x752 folio size for dual-orientation folios.

Default Image Format Choose a default option for the folio. Individual articles can have different Image Format 

settings.

Choose Automatic if you want to let InDesign determine whether to export the pages as JPEG, PNG, or PDF. If you 

want to reduce file size at the possible expense of image fidelity and performance, choose JPEG or PDF. Choosing 

PDF lets users zoom in on pages that do not have interactive content.

Default JPEG Quality If Automatic, JPEG, or PDF is selected for Default Image Format, specify the JPEG Quality. 

Increased quality increases the file size.

Create Local Folio Select this option if you do not want to upload the folio content to the server at this time. You 

can later choose Upload To Folio Producer from the panel menu to upload folio contents.

https://digitalpublishing.acrobat.com/
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For information about troubleshooting the Folio Builder, see Troubleshoot Folio Builder and Troubleshoot article 

upload failures in Folio Builder panel .

Change folio properties

After you create a folio, you can use the Folio Properties dialog box to specify a publication name, change the size, and 

choose cover preview images.

1 In the Folio Builder panel, select a folio.

2 Choose Properties from the Folio Builder panel menu to open the Folio Properties dialog box.

3 Specify the following settings, and then click OK.

Publication Name The Publication Name you specify appears in the viewer. Specify a publication name if you plan 

to publish the folio.

Note: To avoid problems, use only alphanumeric or numeric characters in the the Publication Name. Do not use 

special characters such as apostrophes (‘), or unexpected results may occur on Android devices. This bug is currently 

being addressed.

Size Change the size of the folio only if you have a compelling reason. Changing the size of the folio can cause the 

article layouts to change in unexpected ways.

Cover Preview A preview image represents each folio added to the viewer in the viewer library. Specify the portrait 

and landscape cover images. Create cover images as 72-dpi JPG or PNG files using the same pixel dimensions as 

the target device, such as 1024 x 768.

You can also use the Folio Producer Organizer to edit folios. See “Folio Producer Organizer” on page 74.

Create offline folios

An offline folio, or local folio, is not uploaded to the Folio Producer service on the web. Creating an offline folio is 

especially useful when you’re not connected to the Internet, or if the acrobat.com service is temporarily out of service.

You cannot convert an uploaded folio to an offline folio.

http://kb2.adobe.com/cps/900/cpsid_90004.html
http://cps-internal.corp.adobe.com/cps/918/cpsid_91847.html
http://cps-internal.corp.adobe.com/cps/918/cpsid_91847.html
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An icon indicates that a folio is offline.

1 To create an offline folio, do either of the following:

• Click New in the Folio Builder panel when you are not signed in.

• Click New in the Folio Builder panel, and then select Create Local Folio.

2 Add articles and edit the folio.

You can preview offline folios on your desktop or using Preview on Device.

When you preview or upload an offline folio, the folio is updated automatically to account for changes to the source 

InDesign documents. Choosing Update to update an offline folio is not necessary.

3 To upload the folio, sign in to the Folio Builder panel, select the folio, and choose Upload To Folio Producer from 

the panel menu.

You can upload an offline folio only if the source files are available.

Share folios

Share a folio if you want to let other people review the folio you’re working on or to make it available to them. For 

example, if you’re creating an ad for a publisher, you can share the folio that contains your ad with the publisher. Or, 

if you’re a publisher, you can share a folio with different designers to let them upload articles. 

1 In the Folio Builder panel, select a folio.

2 Choose Share from the Folio Builder panel menu.

3 In the Share dialog box, type the email addresses of the people with whom you want to share your folio. Use a 

comma or semi-colon to separate the email addresses. Press Tab to move to the next field.

4 Type the subject and message, and then click Share.

When recipients open the Adobe Content Viewer on a mobile device, the shared folio is available for downloading.
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If recipients open the folio in the Folio Builder panel, a share icon  appears next to the folio name in the Folio 

Builder. Recipients can open the folio and add articles. However, they cannot edit existing articles. 

Unshare folios To unshare a folio that you shared with others, select the folio in the Folio Builder panel, and choose 

Unshare from the panel menu. Select the recipients with whom you want to unshare, and click OK. Unsharing makes 

the folio unavailable for downloading and removes it from shared recipients’ Folio Builder panel, but it does not 

remove folios that have been downloaded to devices. Deleting a shared folio also makes it unavailable for downloading.

Remove a folio shared with you If someone has shared a folio with you and you no longer want access to it, select the 

folio in the Folio Builder panel and click the trash icon. Deleting the shared folio removes your information from the 

owner’s shared recipients list.

Delete a folio

When you delete a folio, you remove the workspace from the server, and you delete all articles in that folio, but not the 

source documents. If you published a folio to the Distribution Service, use the Folio Producer Organizer to remove 

that folio before deleting it. Avoid removing and deleting retail folios.

❖ Select a folio in the Folio Builder panel, and then click the Trash button.

Create articles and layouts

Folios consist of articles. You can create articles that are either based on InDesign documents or HTML files. You can 

use two methods to add articles to a folio: create an article based on an open document, or import documents from a 

folder.

Create an article from an open document

Articles can include either one or two layouts for portrait and landscape orientation on the mobile device. However, 

you must be consistent within the published folio. All articles in the published folio must be portrait only, landscape 

only, or dual orientation.
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Articles view

1 Open the InDesign document that is designed for digital publishing. See “Designing digital publications” on 

page 22.

The document dimensions can be different from the folio size in two situations. Either the aspect ratios of the folio 

and document page size are identical, or the document is designed for smooth scrolling. For example, you can add 

1024x768 documents to a folio that are set to a 800x600 folio size because both aspect ratios are 4:3. Or, if you create 

a 1024x2000 document with a single page, the added article is set to Smooth Scrolling.

2 In the Folio Builder panel, create or open the folio in which the article will appear.

3 In the Articles view of the Folio Builder panel, click Add. 

4 Specify the following options, and click OK.

Title Specify the article title. The article title appears in the Viewer, so use a real article name such as “City Guide” 

instead of a filename such as “city_guide_h.”

Image Format Specify an image format setting for the article if you want it to be different from the entire folio. For 

example, you can choose PDF for an article to allow pinching and zooming on non-interactive pages.

JPEG Quality If Automatic, JPEG, or PDF is selected for Image Format, specify the JPEG Quality. Increased quality 

increases the file size. 

Add a layout to an article

When you create an article based on an open document, only one layout is created: portrait or landscape. If the article 

appears in a dual-orientation folio, the article requires a second layout.

1 Open the InDesign document that is designed in a different layout orientation from the existing article layout.

2 In the Folio Builder panel, double-click the article to which you want to add the second layout.

3 In the Articles view of the Folio Builder panel, click Add. 

If you’re creating a smooth scrolling article, use the import method to add both layouts. See “Smooth scrolling articles” 

on page 23.
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Import InDesign articles

If you use the appropriate structure and filenaming conventions, you can import either a single article or a set of 

articles. 

1 Create one or more folders containing InDesign documents. See “Structuring folders for imported articles” on 

page 29.

2 In the Folio Builder panel, open the folio in which the article or articles will appear.

3 In the Articles view of the Folio Builder panel, choose Import from the panel menu. 

Import Article dialog box

4 Do either of the following:

• Choose Import A Single Article, click the Location folder icon, and specify an article folder.

• Choose Import Multiple Articles, click the Location folder icon, and specify a folio folder containing article 

folders.

5 Specify the image format settings, and click OK.

If your article folders include .png images on the same level as the InDesign documents, the images are used as table 

of contents icons. If you import multiple articles in which the folio folder includes a sidecar.xml file, the file determines 

the order of articles and populates the article properties. See “Create a metadata sidecar file for importing articles” on 

page 30.

If your articles fail to import properly, see Troubleshoot article upload failures in Folio Builder panel .

Import HTML articles

You can import HTML-based articles into a folio so that it can be displayed in the viewer as an article. One advantage 

of HTML articles is a much smaller file size that is better suited for weekly publications and simple, text-intensive 

articles.

1 Create a folder containing HTML files.

Make sure that you include only the assets you’re using in the folder. All assets in the folder are uploaded, even if 

they’re not used.

2 In the Folio Builder panel, open the folio in which the HTML article will be included.

http://cps-internal.corp.adobe.com/cps/918/cpsid_91847.html
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3 In the Articles view of the Folio Builder panel, choose Import from the panel menu. 

4 Choose Import A Single Article, click the Location folder icon , and specify the HTML folder.

5 Specify the image format settings, and click OK.

HTML article requirements

• You can create a single HTML file that works for both portrait and landscape orientations, or you can create 

separate HTML files for the two orientations. To use separate HTML files for portrait and landscape, add the _v 

and _h suffixes to the end of the HTML filenames, such as “index_h.html.” If you’re creating a single-orientation 

folio, you need only one HTML file. Include the _h or _v suffix for the HTML file in a single-orientation folio.

• Dynamic HTML (DHTML) files currently are not fully supported. 

• For file structure, one method is to place all associated graphics and scripts for the HTML file in the individual 

article folders. Another option is to place associated graphics and scripts for the entire folio in an HTMLResources 

folder. The HTMLResources folder must be imported to the folio from the Folio Builder panel or the Folio 

Producer on the web. See “Import HTMLResources folder” on page 77.

Example of an HTMLResources folder

• Make sure that you use relative paths in your HTML code. If you’re linking to an image on the same level as the 

HTML file, use this approach:

<img src="GlobalImage.jpg"/>

If you’re linking to an image in the HTMLResources folder, use this approach:

<img src="../HTMLResources/GlobalImage.jpg"/>

For information on creating hyperlinks to and from HTML articles, see “Create navto hyperlinks for HTML articles” 

on page 38.

Creating HTML articles for multiple devices

In previous releases, the user guide recommended including the following <meta> tag to provide consistent content 

scaling across mobile devices with different resolutions:

<meta name="viewport" content="width=device-width, initial-scale=1.0, maximum-scale=1.0, 
user-scalable=no, target-densitydpi=device-dpi"/>

However, to enable HTML pagination, either omit this <meta> tag or remove the “user-scalable=no” and “target-

densitydpi=device-dpi” values. If either value appears in the meta tag, the HTML articles are not scaled properly when 

viewed on Android devices.
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Creating HTML articles for Android Viewers

For guidance and requirements on creating HTML articles for Android Viewers, see Create HTML articles for 

Android Viewers.

Paginating HTML articles

If your HTML article is not set to Smooth Scrolling, images or lines of text can be too close to the bottom of the page 

or cropped. You can improve the appearance of pagination in HTML articles. See HTML Pagination.

HTML5 resources

• For information about using Wallaby to convert Flash files to HTML5 files, see From InDesign to HTML5 via Flash.

• For information about creating articles using HTML5, see Johannes Henseler’s article A single file HTML5 

framework.

• For HTML5 tutorials, see http://html5tutorial.net/tutorials/ and http://net.tutsplus.com/category/tutorials/html-

css-techniques/.

• For information on which fonts are available in HTML articles and Web View overlays on the iPad, see 

www.michaelcritz.com/2010/04/02/fonts-for-ipad-iphone/.

• Rufus Deuchler created a video tutorial about using Adobe Muse (code name)  to create HTML content for digital 

publications.

Creating scrubber thumbnails for HTML articles

For InDesign articles, the viewer automatically generates the thumbnails that appear when you drag the scrubber. 

However, generating thumbnails for HTML articles takes more time, sometimes resulting in poorly rendered 

thumbnails. To improve thumbnail performance in HTML articles, you can manually add image files to the HTML 

article folders.

Create png files that are named “scrubberthumbnail_h.png” and "scrubberthumbnail_v.png” (you can also use _l and 

_p suffixes). Add these files to the HTML article folder. There is no size restriction for these images, but note that they 

are scaled down proportionally to a height of 166 pixels. As a point of reference, when thumbnails are generated, 

landscape thumbnails are 221 x 166 pixels, and portrait thumbnails are 125 x 166 pixels.

Manage articles

Use the Folio Builder panel menu to update, copy, and rename articles.

http://kb2.adobe.com/cps/898/cpsid_89801.html
http://kb2.adobe.com/cps/898/cpsid_89801.html
http://kb2.adobe.com/cps/894/cpsid_89492.html
http://goo.gl/D50Tp
http://goo.gl/sClBj
http://goo.gl/sClBj
http://html5tutorial.net/tutorials/
http://net.tutsplus.com/category/tutorials/html-css-techniques/
http://net.tutsplus.com/category/tutorials/html-css-techniques/
http://goo.gl/iRGo
http://tv.adobe.com/watch/muse-code-name-feature-tour/muse-creating-content-for-dps/
http://tv.adobe.com/watch/muse-code-name-feature-tour/muse-creating-content-for-dps/
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Folio Builder panel menu

Change article properties

The article properties you specify determine how the article appears in the viewer.

Article properties
A. Description  B. Kicker  C. Title  D. Byline  

1 In the Folio Builder panel, select an article.

2 Choose Properties from the Folio Builder panel menu.

B

A

C
D
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3 Specify the following options and click OK.

Title Specify the article title as it should appear in the viewer. The Title value is different from the Article Name, 

which appears in the Folio Builder panel. The Article Name is used for creating links between articles, not the Title.

Description Describe the article. The description appears when the folio is viewed in browse mode.

Table of Contents Preview When users tap the Table of Contents button in the viewer’s navigation bar, a 70x70-

pixel table of contents icon appears next to each article. A default table of contents icon is generated automatically 

from the first page of the article. To use a different icon, click the folder icon and choose a PNG file.

Viewer table of contents

Smooth Scrolling In the Smooth Scrolling column, specify whether each stack scrolls continuously or by snapping 

to the page. Smooth Scrolling works only in the vertical direction for swiping up and down. The document cannot 

include multiple pages. You can apply the Smooth Scrolling setting to landscape only, portrait only, or both layout 

orientations. See “Smooth scrolling articles” on page 23.

Horizontal Swipe Only When you select Horizontal Swipe Only for an article, users browse through the article by 

swiping left and right instead of up and down. This option was previously called “Flatten.” See “Swiping articles 

horizontally” on page 24.

Byline Specify the author’s name.

Kicker The section title of a magazine, such as “Reviews,” “Features,” or “Editorial.”

Advertisement Select this option if the article is an advertisement. Ads do not appear in the viewer table of 

contents.

You can also use the Folio Producer Editor to edit article properties. See “Folio Producer Editor” on page 75.
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Edit and update an article

When you create an article or an article layout, the content of the InDesign document is uploaded to the workspace on 

the server. When you edit and save a document that is part of an article, changes are saved only locally until you update 

the article.

1 To edit a document, double-click a layout in Folio Builder, and make changes. You can use any method to open the 

document.

You don’t need to be signed in or connected to edit an article document.

2 After you edit and save the document, sign in to the Folio Builder panel, and select the article containing the 

document you edited.

3 Choose Update from the Folio Builder panel menu.

When you update an article, both layouts are updated.

Copy an article to another folio

Once you create an article based on a document, you don’t need to create another article if you want it to appear in a 

different folio. Instead, copy the article from one folio to another.

1 In the Folio Builder panel, open the folio containing the article, and select the article.

2 Choose Copy To from the Folio Builder panel menu.

3 In the Copy To dialog box, choose the target folio, and then click OK.

You can also use the Folio Producer to copy articles between folios.

Rename an article

When you rename an article, you risk breaking links that target the renamed article.

1 In the Folio Builder panel, select an article.

2 Choose Rename from the Folio Builder panel menu, and then enter a different name.

Delete an article

When you delete an article, you remove it from the folio and from the workspace on the server. However, the source 

InDesign documents are not deleted.

1 In the Folio Builder panel, select an article.

2 Click the Trash button, and then click Delete.

Change the order of articles

To change the order of articles, drag and drop them in the Folio Builder panel, or use the Folio Producer Editor to 

change the article order. See “Folio Producer Editor” on page 75.

You can also use the sidecar.xml file to rearrange articles and update metadata. See “Create a metadata sidecar file for 

importing articles” on page 30.
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Preview folios and articles

Use Adobe Content Viewer to preview folios. The Adobe Content Viewer is available as a desktop application or as a 

mobile device application. The Desktop Viewer is installed automatically when you install the Folio Producer tools. 

The viewer for mobile devices is available for download in the iPad App Store, Android Market, and PlayBook App 

World. Search for “Adobe Content Viewer.” 

As soon as you create a folio or article, you can preview it using the Desktop Viewer or the viewer on your mobile 

device. However, to preview a folio, the articles in the folio must have the same aspect ratio and layout orientation. For 

example, if your folio includes a horizontal-only article mixed with dual-orientation articles, you cannot preview the 

folio. Instead, preview only the article.

Use the Desktop Viewer to preview content

The Adobe Content Viewer for the Desktop (also called the Desktop Viewer) is an AIR app that lets you preview folios 

on your desktop.

The following features are currently not supported in the Desktop Viewer: articles exported with PDF image format 

and articles set to Horizontal Swipe Only.

1 In the Folio Builder panel in InDesign, select the folio or article that you want to preview.

If you select a folio, all the articles in that folio are available for preview. If you select an article, only that article can 

be previewed.

2 Use the Preview button at the bottom of the panel.

While previewing, press Ctrl/Command+r to rotate the orientation. Press the + or - keys to zoom in and out.

You can also preview a document by choosing File > Folio Preview or clicking Preview in the Overlay Creator panel. 

It isn’t necessary to create an article beforehand. This method is especially useful when your computer is not connected 

to the Internet. However, only one layout is previewed. Use a different method to preview both layouts.

Use the iPad Viewer to preview content

The Adobe Content Viewer for the iPad is a generic version of the viewer used for testing the digital content you create 

on the iPad. The iPad Viewer is updated whenever the Folio Producer tools are updated.

The Adobe Content Viewer library checks two locations for folios—the acrobat.com server and the Distribution 

Service. The acrobat.com server contains all folios that appear in your Folio Builder panel. The Distribution Service 

contains all published folios. A blue stripe in the upper left corner of the folio thumbnail indicates an acrobat.com folio. 

Any folio published as Retail does not appear in the Adobe Content Viewer.
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A blue stripe indicates a folio hosted on the acrobat.com server.

1 If you have previously download the Adobe Content Viewer, remove the previous version from your iPad and from 

iTunes, and then sync your iPad.

2 On your iPad, download the Adobe Content Viewer from the App Store.

3 Start the Adobe Viewer app.

4 Sync your iPad so that the Adobe Viewer app is added to iTunes.

5 Start Adobe Viewer on the iPad, and sign in using the same Adobe ID you use to sign in to the Folio Builder panel.

The folios to which you have access are available for downloading and previewing.

Navigate using the viewer

The following navigation techniques work whether you’re using the generic Adobe Content Viewer or a custom 

viewer.

• Rotate the mobile device to display either the horizontal or vertical version of the file.

• Swipe up and down to read an article. Swipe left and right to switch to a different article (or to switch to different 

pages of a flattened article).

• Tap interactive areas to play movies, rotate 360 images, and activate other interactive items.
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• Tap a non-interactive area to display the navigation bars. Tap the Home icon to jump to the beginning of the folio. 

Tap the Back button to return to the previous view. Tap the Table of Contents icon in the upper-left corner to view 

the table of contents. Tap the Browse icon in the upper-right corner for a bird’s eye view of the folio. Drag the 

Scrubber to scroll through article thumbnail images.

• Tap the title in the navigation bar to return to the first stack. Double-tap the title to toggle between the title and title 

plus version display. Triple-tap the title to reset the issue so that each article starts at the first page instead of the 

previously viewed page.

Adobe Content Viewer
A. Home button  B. Back button  C. Table of Contents button  D. Browse button  E. Scrubber  

Use the Android Viewer to preview content

The Adobe Content Viewer for the Android is a generic version of the viewer used for testing the digital content you 

create on the mobile devices running Android 2.2 or later. The Android Viewer is updated whenever the Folio 

Producer tools are updated.

1 If you have not already done so, download AIR 2.6 Runtime or later from the Android Market.

2 Download Adobe Content Viewer from the Android Market.

For more information, see https://market.android.com/details?id=air.com.adobe.contentviewer.

3 Start Adobe Viewer on the Android device, and sign in using the same Adobe ID you use to sign in to the Folio 

Builder panel.

The folios to which you have access are available for downloading and previewing.

A B DC

E

https://market.android.com/details?id=air.com.adobe.contentviewer
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Features not supported in Android Viewer

Some of the features that work in the iPad Viewer are not supported in the Android Viewer.

• Panorama overlays, inline videos, and pan & zoom PDF articles are not supported.

• Web Content overlays and HTML articles are not fully supported.

Use the PlayBook Viewer to preview content

The Adobe Content Viewer for the BlackBerry® PlayBook™ is a generic version of the viewer used for testing the digital 

content you create on the PlayBooks. The PlayBook Viewer is updated whenever the Folio Producer tools are updated.

1 If you have not already done so, download AIR 2.6 Runtime or later from BlackBerry App World.

2 Download “Adobe Content Viewer” from App World.

The Adobe Content Viewer is located here: https://appworld.blackberry.com/webstore/content/45624

3 Start Adobe Viewer on the Android device, and sign in using the same Adobe ID you use to sign in to the Folio 

Builder panel.

The folios to which you have access are available for downloading and previewing.

Features not supported in PlayBook Viewer

Some of the features that work in the iPad Viewer are not supported in the PlayBook Viewer.

• Panorama overlays, HTML articles, right-edge binding, and pan & zoom PDF articles are not supported.

• Web Content and Scrollable Content overlays are not fully supported.

Use Preview on Device

Instead of downloading folios from the server, you can use the Preview on Device feature to copy a folio directly from 

your computer to the mobile device.

Preview on Device for iPad (Mac OS only)

Preview on Device for the iPad is not yet available.

Preview on Device for Android

1 Do the following to make sure that your Android device can communicate properly with your computer.

• Turn on USB Debugging. The location of the USB Debugging option varies depending on your Android device. 

For some devices, it’s located in Settings > Applications > Development.

• (Windows only) Install the necessary device drivers to allow your Android device to communicate with your 

computer. The Flash Builder help includes useful information at Debug an application on a Google Android 

device  and Install USB device drivers for Android devices (Windows) .

2 Connect your Android device to your computer.

3 Start Adobe Content Viewer (v1.9 or later).

4 In the Folio Builder panel in InDesign, select the folio you want to preview, and then choose the device name from 

the Preview menu at the bottom of the panel.

The folio is copied from your computer to your Android device.

https://appworld.blackberry.com/webstore/content/45624
http://help.adobe.com/en_US/flex/mobileapps/WSe4e4b720da9dedb5-2d82208b12e46a72ded-8000.html
http://help.adobe.com/en_US/flex/mobileapps/WSe4e4b720da9dedb5-2d82208b12e46a72ded-8000.html
http://help.adobe.com/en_US/flex/mobileapps/WSa8161994b114d624-33657d5912b7ab2d73b-7fdf.html#WSa8161994b114d624-33657d5912b7ab2d73b-7fdc
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Chapter 5: Assemble and Publish

Produce and publish folios

The Digital Publishing Suite Dashboard includes the tools you need to publish folio and build custom viewer apps. Use 

the Folio Producer to put the finishing touches on your folio and then publish it. Use the Viewer Builder to create a 

custom viewer app for Apple App Store, Android Market, or BlackBerry App World.

Only Professional and Enterprise subscribers can publish folios and create custom viewer apps.

Related Articles

Publishing overview

Anyone who has installed the Folio Producer tools can create a folio and share it with other people. To create a custom 

viewer app and submit it to the Apple App Store, Android Market, or a different store, a subscription to the Digital 

Publishing Suite is required.

For information on subscribing to the Digital Publishing Suite, see www.adobe.com/products/digitalpublishingsuite/.

Types of custom viewer apps

The Adobe Content Viewer lets you preview folios and share them with individuals. To make your folios available in 

a store, you use the Viewer Builder to create a custom viewer app.

Single-folio viewer app

In a single-folio viewer app, the folio is built in to the viewer app. The viewer has no library. You use the Export button 

in the Folio Producer Organizer to create a .zip file of the folio, and then you use Viewer Builder to specify that folio. 

Then you upload the app to the Apple Store.

You can create a single-folio viewer app for iPads but not for Android devices.

To do this: Go here:

Understand the types of viewer apps “Types of custom viewer apps” on page 69

Organize, edit, and publish folios “Folio Producer Organizer” on page 74

Arrange articles and edit metadata “Folio Producer Editor” on page 75

Create a Single Edition viewer app “Single Edition overview” on page 8

Create a custom viewer app to submit to a store “Viewer Builder” on page 84

http://www.adobe.com/products/digitalpublishingsuite/
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A single-folio viewer does not have a library.

Multi-folio viewer app

In a multi-folio viewer app, you use the Viewer Builder to create a viewer that is essentially a shell. You then use the 

Folio Producer Organizer to publish folios to the Adobe Distribution Service. Customers use the viewer’s library to 

download folios to which they’re entitled. Use a different Adobe ID for each multi-folio viewer app you create. See 

“Using Adobe IDs for digital publishing” on page 5.
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The library of a multi-folio viewer lets customers download, view, and purchase folios.

You can create two kinds of folios for a multi-folio viewer app—free and retail. Any folio you publish that is set to Free 

and Public automatically appears in the custom viewer’s library with a Download button.

Any folio you publish that is set to Retail and Public must be tied to an in-app purchase you set up in iTunes Connect 

or Android Market in-app Billing. Use the same Product ID when you publish the folio that you use when you set up 

the in-app purchase. Retail folios appear in the custom viewer’s library with a Buy button. When customers tap Buy, 

they can purchase the folio.

Multi-folio subscription viewer app

A viewer app with subscriptions includes a Sign In button and a library option that lets customers select the type of 

subscription they want. For example, they can select a 3-Month, 6-Month, or 1-Year option. When they sign in, the 

viewer checks with the store to determine which folios they're entitled to download.

You can set up a subscription that works only with the store. If you’re an Enterprise customer, you can set up a custom 

entitlement server and give customers the choice of subscribing through the store or through your service.
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The library of a sample subscription viewer

Enterprise signed viewer app

Enterprise subscribers can create iPad apps for internal distribution only. An enterprise signed iPad viewer app is 

distributed within the company rather than downloaded from the Apple Store. See “Creating an enterprise signed iPad 

viewer app” on page 100.

About entitlement and fulfillment

Entitlement is the permission to download an item. Fulfillment is the process of making entitled content available to 

customers for downloading. The store (such as the Apple App Store or Android Market) is where viewer apps are 

available for downloading. You use the Viewer Builder to create custom apps for the store. The Distribution Service is 

where folios are available for downloading. You use the Folio Producer to publish folios to the Distribution Service.

When customers download your viewer app and open the library, the viewer checks the Distribution Service for folios 

that are available for downloading.

Digital Publishing Suite Dashboard

Anyone with a valid Adobe ID can sign in to the Digital Publishing Suite Dashboard and edit folios. The Adobe ID you 

use to sign in determines which features you can use. Only subscribers to the Digital Publishing Suite can publish folios 

and create custom viewer apps for commercial purposes. 

https://digitalpublishing.acrobat.com

http://digitalpublishing.acrobat.com
https://digitalpublishing.acrobat.com
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DPS subscribers have access to the publishing tools on the Dashboard
A. Folio Producer for assembling and editing folios  B. Viewer Builder for create custom viewer apps  C. Analytics page for tracking user data  

Digital Publishing Suite subscription types

There are two Digital Publishing Suite edition types: Enterprise and Professional.

Enterprise Users with an Enterprise account have access to all the tools and services, including additional Omniture 

analytics capabilities.

Professional Users with a Professional account can use the authoring tools and the Dashboard tools and services, but 

with limited analytics powered by Omniture.

Digital Publishing Suite account types

When you subscribe to the Digital Publishing Suite, an Adobe representative works with you to set up various 

accounts, depending on your needs. Each Adobe ID can be assigned specific roles.

Admin account An Admin account is used to assign account types.

Application ID account An Application ID ties published folios to a specific multi-folio custom viewer. For example, 

if a publisher creates magazines about outdoor sports, one Adobe ID should be created for each viewer app, such as 

“cycling@publisher.com” and “hiking@publisher.com.” 

Avoid using an individual’s name (such as “johnsmith@publisher.com”) for the Application ID unless you have an 

existing custom viewer tied to that individual’s Adobe ID.

Viewer Builder ID account Use the Viewer Builder ID to sign in to the Viewer Builder and create custom viewer apps.

More Help topics 

“Using Adobe IDs for digital publishing” on page 5

A

B

C
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Folio Producer Organizer

Clicking the Folio Producer link on the Dashboard displays the Folio Producer. With the Folio Producer, you can 

organize and edit folios. If you sign in using a subscription account, you can publish folios. The Folio Producer 

includes an Organizer page that displays available folios and an Editor page that displays the articles in a folio.

Available folios displayed in Organizer panel

To open the Folio Producer Organizer directly, choose Folio Producer from the Folio Builder panel menu. 

Assemble folio articles

Any article that you create or import into a folio in the Folio Builder panel appears in the folio. In addition, you can 

use two other methods to add articles to a folio.

Share In the Folio Builder panel, select the folio, and choose Share from the panel menu. Anyone with whom you 

share the folio can add articles to the folio. See “Share folios” on page 56.

Copy To In the Folio Builder panel, select the article, and choose Copy To from the panel menu. Then copy the article 

to a different folio. You can also copy an article using the Folio Producer Editor. See “Copy an article to another folio” 

on page 64.

Change folio publishing settings

Use the Organizer panel to specify folio information and change settings. Some of these settings are for internal 

tracking purposes. Settings marked with an asterisk (*) are necessary for publishing the folio.

1 Sign in to the Adobe Digital Publishing Suite Dashboard using the appropriate Adobe ID.

2 In the Dashboard, click Folio Producer.

3 Change the properties of the folio.

Locked Select this option to prevent anyone from uploading a new version of the article or changing article 

metadata. A locked icon appears next to the article in the Folio Builder panel of anyone who has access to the folio.

Active Select this option to indicate that the folio is in production. A green mark appears next to the folio name in 

the Folio Builder panel.

https://digitalpublishing.acrobat.com/
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Folio Builder panel
A. Active folio  B. Shared folio  

Right Edge Binding Selecting this option displays articles from right to left rather than left to right in the viewer. 

This option is especially important for Asian languages.

Folio Name The Folio Name appears in the Folio Producer and in the Folio Builder panel, but it does not appear in 

the viewer.

Publication Name The Publication Name appears in the viewer library and in the viewer navigation bar. 

Folio Number The Folio Number can be a number or a description, such as “May 2012.”

Publication Date The Publication Date setting determines the order of folios in the library. The newest folios 

appear at the top. The Publication Date setting is especially important for subscription viewers in which customers 

are entitlement to folios within a specific duration as determined by the Publication Date settings.

Description The Description is for internal use only. It does not appear in the viewer.

Vertical/Horizontal Preview Specify .png or .jpg files for the images that appear in the viewer library.

Folio Producer Editor

With the Folio Producer Editor, you can edit article settings, some of which are not available in the Folio Builder panel. 

The Editor includes two views: a Thumbnail view for previewing articles and changing properties and a List view for 

ordering, locking, and changing other settings.

A

B
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Available articles in folio
A. List view and Thumbnail view  B. Show horizontal or vertical layout  C. Selected article  

Use Thumbnail view to preview articles

1 Sign in to the Adobe Digital Publishing Suite Dashboard, and click Folio Producer.

2 Select the folio you want to edit and click Open.

3 Do any of the following:

Change the order Drag an article to change its order.

Edit article properties Changes you make to the Article Properties settings are reflected in the Folio Builder panel. 

See “Change article properties” on page 62.

View horizontal and vertical layouts Click the Horizontal and Vertical buttons to change the layout. Drag the 

Thumbnail Size slider to resize article thumbnails.

Add an article Click Add, and then choose article in the folio from which you want to copy. You can also copy an 

article to another folio by choosing Copy To from the article pop-up menu.

Rename an article Choose Rename from the article pop-up menu, and then rename the article. Renaming an article 

changes the Article Name, not the Article Title that appears in the viewer. Renaming an article can result in broken 

navto links between articles. 

Use List view to edit article settings

Use the List view to reorder articles manually, change download priorities, and edit other settings.

A B C

https://digitalpublishing.acrobat.com/
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Folio articles displayed in List view

1 In the Folio Producer Editor, click the List View button.

2 Change any of the following settings:

Order Enter numbers to re-order the articles.

Locked Lock an article so that it cannot be updated.

Article Name The Article Name appears in the Folio Builder panel and Folio Producer. More importantly, the 

Article Name is used when creating links between articles, so be careful when changing the Article Name setting.

Article Title The Article Title appears in the viewer. You can change the article title without affecting links between 

articles.

Download Priority When customers download the custom viewer, they can view the file while it’s still being 

downloaded. Unless you change the download priority, the articles are downloaded from first to last.

Tags Tags appear in Browse Mode of the viewer.

Import HTMLResources folder

When you create articles based on HTML instead of InDesign documents, you can set up a resources folder for sharing 

images, scripts, and CSS files. The resources folder must be named “HTMLResources.zip.” You can import only one 

HTMLResources folder in a folio. For information on creating HTML articles, see “Import HTML articles” on page 59.

Note: To create the .zip file, select the contents of the HTMLResources folder, not the folder itself.

If several people are working on HTML articles, make sure that they have a up-to-date copy of the HTMLResources 

folder so that they can refer to it.

1 Open the folder containing the HTML resources, select the contents, and compress it into a .zip file.

2 Sign in to the Adobe Digital Publishing Suite Dashboard. Click Folio Producer.

3 Select a folio, and choose Open.

4 In the Folio Producer Editor, click the Import HTML Resources button .

5 Click Browse, select the HTMLResources.zip file, and then click Open.

If you need to edit the HTMLResources.zip file, make the changes, create a new zip file, and import it again. 

You can also import the HTMLResources.zip file using the Folio Builder panel.

https://digitalpublishing.acrobat.com/
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Publish folios to the Distribution Service

When folios and articles are created, they’re uploaded to an Acrobat.com workspace on the web, but they do not yet 

appear on the Distribution Service (sometimes called the “fulfillment server”). The Distribution Service stores all the 

folios that customers can download.

To publish folios as retail or public, you must sign in to the DPS Dashboard using a subscription account. However, 

anyone can publish folios as private to improve downloading performance.

Publishing content to the Distribution Service

1 Sign in to the Adobe Digital Publishing Suite Dashboard.

2 In the Dashboard, click Folio Producer. In the Folio Producer Organizer, select a folio and click Publish.

3 Set the status of the folio.

Private or Public When you set a folio to Public, customers can download it as soon as the folio is available in the 

store. A DPS subscription is required to publish a folio as Public. If a folio is set to Private, it is not available for 

customers to download in a custom viewer app. It is available only in the the Adobe Content Viewer.

Free or Retail Set a folio status to Retail to allow customers to download it only if they pay for it through an in-app 

purchase or a subscription. For retail folios, go through the In App Purchase process on the Apple developer site 

or the In App Billing process in the Android Market site to determine the price of the retail folio download.

Any folio published as Retail does not appear in the Adobe Content Viewer. Preview retail folios using the custom 

development app you create.

Important: Use a different Product ID for each folio. For retail folios, do not set the status to Free and set it to Retail 

later. Doing so can prevent the folio from being available in the custom viewer. Publish retail folios as Public and 

Retail.

4 Specify the Product ID.

For best results, use the com.publisher.publication.issue format (such as com.adobepress.dps_tips.july2011) to 

specify the Product ID.

For retail content, make sure that you use the same Product ID in the Publish Folio dialog box and in store, such as 

the In App Purchase Process for the iPad.

5 Click Publish.

https://digitalpublishing.acrobat.com/
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The folio is not published if it includes articles with conflicting orientations or aspect ratios. If the folio is published, 

the Publish button is replaced by an Update button, and the Remove button is active.

Update published folios

When the Adobe Content Viewer detects that a downloaded folio has been updated, it prompts users to download the 

updated folio. Make sure that the Publication Name, Folio Number, and Size values remain unchanged.

1 Make the necessary changes to the folio and articles.

If you edit the source documents of an article, use the Update command in the Folio Builder panel.

2 Navigate to the Folio Producer Organizer.

3 Make sure that the Publication Name and Folio Number settings of the folio are identical to those of the existing 

folio.

If either of these settings are different, the new folio is treated as a separate issue.

4 Select the folio and choose Update.

5 Specify the appropriate status settings and Product ID.

If you specify a Product ID that differs from the original, the Product ID is updated.

If your folio is a retail version, make sure that your Product ID matches the Product ID specified during the In App 

Purchase process for iPad apps or the In App Billing process for Android apps. If you specify a different Product 

ID, the folio fails to appear in your custom viewer app.

Export folios for single-folio viewers

To create a single-folio viewer, you need to export a folio as a .zip file that you can specify in the Viewer Builder. Before 

you can export a folio, you must publish it.

1 Sign in to the Adobe Digital Publishing Suite Dashboard using a subscription account.

2 In the Dashboard, click Folio Producer. In the Folio Producer Organizer, publish the folio. See “Publish folios to 

the Distribution Service” on page 78.

3 In the Folio Producer Organizer, select the published folio and click Export.

4 Specify the name and location of the .zip file, and then click Save.

You specify this .zip file when using the Viewer Builder to create a single-folio viewer app. See “Create a custom viewer 

app for the iPad” on page 84.

Create folio renditions

Renditions are important for the platforms such as Android in which devices have multiple dimensions.

When you publish content, two settings determine whether a folio is a rendition or a different issue. These settings are 

Folio Name and Size. You specify these settings when using the Folio Builder panel to create a folio.

https://digitalpublishing.acrobat.com/
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Creating multiple folio renditions that have the same Folio Name settings and different Size settings

When the Viewer checks the Distribution Service, it offers only the rendition that most closely matches the mobile 

device.

For example, if you upload one folio with a 1232x752 Size setting and another folio with a 1024x600 setting, the 

Motorola Xoom viewer downloads only the 1232x752 rendition while the Samsung Galaxy Tab 7 viewer downloads 

only the 1024x600 rendition.

More Help topics 

“Creating documents for multiple devices” on page 27

Updating folios published with prerelease tools

If you used the Content Bundler to publish folios for a multi-folio viewer, the folio does not appear in the Folio Builder 

panel or the Folio Producer. However, published folios are still available for your customers to download and view. 

You can continue to edit and update these folios using the Content Bundler as long as it is available.

When you update your workflow to use the Folio Builder panel, you can create folios that are available along with the 

existing folios. Make sure that you use the same Adobe ID that you use in the Content Bundler. Also, update and re-

submit your custom viewer so that it can display folios created using the newer tools.



81USING DIGITAL PUBLISHING SUITE

Assemble and Publish

Last updated 11/16/2011

At this time, if you want to edit an existing folio published using the Content Bundler, continue to use the Content 

Bundler. 

Checklists for custom viewer apps

Using the Viewer Builder to create a custom viewer app is a straight-forward process if you have all the files and 

information you need. Use the appropriate checklist to make sure that you have the required files.

Checklist for single-folio viewer (iPad only)

The following files and information are required to create a single-folio viewer for the iPad.

For information on creating certificates and images to submit a custom viewer to the Apple App Store, download the 

“Publishing for iPad Companion Guide PDF” from the Adobe Digital Publishing Suite Dashboard. In addition, the 

Apple Developer site includes links to instructional videos for creating certficates.

General

• Adobe ID used for application

• Single Edition serial number (Single Edition only)

• .zip file of folio exported using Folio Producer Organizer

Files required to secure your app

• Distribution P12 certificate (and password)

• Distribution mobileprovision file

• Developer P12 certificate (and password)

• Developer mobileprovision file

Artwork required to brand your app

• App Icons: 29x29, 50x50, 72x72 and 512x512 pixel icons in PNG format. You do not need to add the shine effect 

or rounded corners.

• Splash Screens: 1024x768 and 768x1024 pixel images in PNG format

More Help topics 

“Single Edition overview” on page 8

“Create a custom viewer app for the iPad” on page 84

Checklist for multi-folio viewer (iPad)

The following files and information are required to create a multi-folio viewer for the iPad.

Folios

• Adobe ID used for application

• At least one free folio published as public using application Adobe ID

https://digitalpublishing.acrobat.com/
https://developer.apple.com/ios/manage/overview/
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• In-app purchases for all published retail folios. Use the same Product ID when creating the in-app purchase and 

publishing the folio.

Files required to secure your app

• Distribution P12 certificate (and password)

• Distribution mobileprovision file

• Developer P12 certificate (and password)

• Developer mobileprovision file

• Production push P12 certificate and password (optional)

• Developer push P12 certificate and password (optional)

Artwork required to brand your app

• App Icons: 29x29, 50x50, 72x72 and 512x512 pixel icons in PNG format. You do not need to add the shine effect 

or rounded corners.

• Splash Screens: 1024x768 and 768x1024 pixel images in PNG format

More Help topics 

“Create a custom viewer app for the iPad” on page 84

Checklist for subscription viewer (iPad)

Certain files and information are required to create a multi-folio subscription viewer for the iPad.

Folios

• Adobe ID used for application

• At least one free folio published as public using application Adobe ID

• In-app purchases for all published retail folios. Use the same Product ID when creating the in-app purchase and 

publishing the folio.

• In-app purchases for all subscription durations.

• Shared secret associated with application Adobe ID (see “Account Administration tool” on page 98)

Files required to secure your app

• Distribution P12 certificate (and password)

• Distribution mobileprovision file

• Developer P12 certificate (and password)

• Developer mobileprovision file

• Production push P12 certificate and password (required for Newsstand)

• Developer push P12 certificate and password (required for Newsstand)

Artwork required to brand your app

• App Icons: 29x29, 50x50, 72x72 and 512x512 pixel icons in PNG format. You do not need to add the shine effect 

or rounded corners.

• Splash Screens: 1024x768 and 768x1024 pixel images in PNG format
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• Newsstand icon: 96x128 pixel icon in PNG format (required for Newsstand)

More Help topics 

“Create a custom viewer app for the iPad” on page 84

Checklist for multi-folio viewer (Android and Amazon)

The following files and information are required to create a multi-folio viewer for the Android Market and Amazon 

Appstore. For information about creating these files, see Publishing Process for Android Devices.

Folios

• Adobe ID used for application

• At least one free folio published as public using application Adobe ID (recommended)

• In-app billing for all published retail folios. Use the same Product ID when creating the in-app billing and 

publishing the folio.

Files required to secure your app

• Valid P12 certificate (and password)

Artwork required to brand your app

• App Icons: 36x36, 48x48, 72x72 pixel icons in PNG format. 

• Splash Screens: 1280x800 and 800x1280 pixel images in PNG format

More Help topics 

“Create a custom viewer app for Android and Amazon devices” on page 90

Checklist for multi-folio viewer (PlayBook)

The following files and information are required to create a multi-folio viewer for the BlackBerry PlayBook. For 

information about creating these files, see Publishing Process for BlackBerry PlayBook.

Folios

• Adobe ID used for application

• At least one free folio published as public using application Adobe ID (recommended)

• In-app billing for all published retail folios. Use the same Product ID when creating the in-app billing and 

publishing the folio.

Files required to secure your app

• Valid P12 certificate (and password)

Artwork required to brand your app

• App Icon: 86x86 pixel icon in PNG format. 

• Splash Screens: 1024x600 and 600x1024 pixel images in PNG format

http://kb2.adobe.com/cps/900/cpsid_90052.html
http://kb2.adobe.com/cps/915/cpsid_91589.html
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More Help topics 

“Create a custom viewer app for PlayBook devices” on page 94

Viewer Builder

Viewer Builder lets you build a custom viewer app that you can submit to the stores such as the Apple Store and 

Android Market. The Viewer Builder is currently available only for Mac OS.

Use the Viewer Builder to create viewer apps for single-folio, multi-folio, and subscription viewer apps. You cannot 

create single-folio viewer apps for the Android Market, Amazon Appstore, or BlackBerry App World at this time.

To download the newest version of the Viewer Builder, go here: www.adobe.com/go/digpubsuite_vb_mac. Or, you 

can delete the existing version of the Viewer Builder from the Applications folder and click the Viewer Builder link on 

the DPS Dashboard.

More Help topics 

“Publishing overview” on page 69

“Checklists for custom viewer apps” on page 81

Create a custom viewer app for the iPad

Use the Viewer Builder to create a custom viewer app for the iPad. If you specify valid files and information, Viewer 

Builder generates both a development app and a distribution app. The development app is for testing. If it works 

properly, submit the distribution .zip file to the Apple Store.

The information such as certificates and passwords that you provide is not stored on the Adobe server. Only the 

application files are stored on the Adobe server.

Viewer Builder requirements for creating iPad viewer apps

System requirements:

• Mac OSX 10.6 Snow Leopard or later for iPad viewer apps

• Internet connection

• Viewer Builder. Download the Viewer Builder from the Digital Publishing Suite Dashboard.

• A valid Adobe ID provisioned to use the Viewer Builder

Create a custom viewer app

1 Obtain the required files and information. See “Checklists for custom viewer apps” on page 81.

2 Download and install the Viewer Builder.

The Viewer Builder is available on the Digital Publishing Suite Dashboard.

3 Start the Viewer Builder and sign in using a valid Adobe ID.

The Adobe ID you use to sign in to the Viewer Builder may be different from the Adobe ID you use to specify the 

Title ID in the Viewer Details panel.

The Account Administration tool lets you or the administrator assign the Viewer Builder role to an Adobe ID. See 

“Account Administration tool” on page 98.

http://www.adobe.com/go/digpubsuite_vb_mac
https://digitalpublishing.acrobat.com/
https://digitalpublishing.acrobat.com/
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4 Click New, select iPad, and then click Next. 

5 Specify the requested files and information.

Note: Do not use the same Adobe ID to create multiple viewer apps. 

Viewer Details panel

The Viewer Details panel lets you provide your viewer names and account ID information.

Viewer Name Provide a viewer name that appears below the App icon on the iPad. As a general rule, use 13 characters 

or fewer to avoid truncating the name.

To test your App name on the iPad, open a website in iPad Safari, choose Add to Home Screen from the Safari menu, 

and then type the desired Viewer name. If the name is truncated, use a smaller name.

Viewer Version Specify the most recent viewer.

The Viewer Builder includes a previous version for backup purposes.

Viewer Type Specify the viewer type (see “Types of custom viewer apps” on page 69). The availability of some options 

depends on the type of account.

• Multi-Issue A multi-folio viewer app includes a library that lets users download content that is hosted on the Adobe 

Distribution Service.

• Built-in Single Issue A single-folio app includes built-in content. When you select this option, the Exported Folio 

option appears. Specify the .zip file created using the Export option in the Folio Producer Organizer.

• Multi-Issue with Entitlement (Enterprise only) Create a viewer app that uses a custom entitlement server to 

determine which customers can download content. If you select this option, you use your own subscription service. 

Consult with Apple. Entitlement only apps cannot be enabled for Newsstand.

• Multi-Issue with iTunes Subscription Create a viewer app that uses the Apple App Store subscription model. 

• Multi-Issue with Entitlement and iOS Subscription (Enterprise only) Create a viewer app that uses a custom 

entitlement server to determine which customers can download content. Customers can subscribe either through your 

subscription service or through the Apple App Store.

Title (Library View) Provide the title that will appear at the top of the viewer library. For best results, use no more than 

35 characters.

PDF Zooming Enabled Select this option to allow your users to pinch and zoom non-interactive pages. Make sure that 

you select the PDF export option when creating your folio.

URL Scheme Specify the custom URL scheme that launches the Viewer app from Safari and other apps. This option is 

available only if you specify a subscription or entitlement option. To ensure uniqueness, Apple recommends that you 

use the reverse-DNS format (com.publisher.publication). 

For example, suppose you specify “com.sportspub.kayaking” as the URL scheme. If you embed a 

“com.sportspub.kayaking://” link on your webpage, clicking the link from the mobile browser opens the viewer app. 

For more information, see Apple’s developer website.

Exported Folio Specify the .zip file or .folio file to be built in with the viewer. To create a .zip file, use the Export option 

in the Folio Producer Organizer. See “Export folios for single-folio viewers” on page 79.

Title ID/Password Provide the appropriate Adobe ID and password for your app. Specify the same Adobe ID you use 

to create folios for this title. The Adobe ID for the app can be different from the Adobe ID used to sign in to Viewer 

Builder.
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Supported Languages iTunes displays the languages in which the viewer app is available. The viewer interface is 

translated into multiple languages, but your folio content most likely isn’t. Select at least one language in which your 

viewer should appear.

Entitlement Details (Enterprise only)

The following options appear if you choose one of the entitlement options for Viewer Type.

Note: For detailed information about setting up a custom entitlement server, contact your Adobe representative.

Service URL Specify the main URL for your entitlement service. An entitlement service is required for enabling 

subscriptions.

Service Auth URL Specify the URL where the authentication service is hosted. The authentication service indicates 

when users have signed in.

Integrator ID Adobe provides the Integrator ID when your entitlement account is provisioned within our servers. This 

option is available only to DPS Enterprise customers.

Create Account URL Specify the URL where customers can sign up for a subscription through the publisher, not 

through the Apple subscription process. This URL is used when users tap a “Subscribe Now” button in your Viewer.

Optional Remote Subscription Page URL Specify the URL where customer can perform subscription tasks, such as 

looking up an existing print subscription.

Forgot Password URL Specify the URL where customers can retrieve their forgotten password.

Optional Existing Subscription URL Specify the URL where customers can can indicate an existing print subscription 

while signing up for a digital subscription. Leave this field blank to disable the “I have a print subscription” link button 

in the viewer.

Send App ID and Version This option allows the Viewer app’s ID and Version strings to be sent in entitlement API 

calls.

Banner Page URL Specify the URL that displays the subscription banner. This banner appears in the upper section of 

the viewer library. This banner should include a 130-pixel wide area that acts as a “Subscribe Now” button.

Offline Banner Assets Select the .zip file containing the assets to be used as the banner if the user is not connected to 

the internet. The .zip file should include a single HTML file, one or more image files, and optional CSS files. The .zip 

file should not contain subfolders; all content should be on the same level.

Banner Height Specify the height of the banner that appears in the viewer library.

Subscription Details

The following options appear if you choose one of the subscription options for Viewer Type.

Landscape Subscription Tile Specify a 463x135-pixel background image that describes the Apple subscription when 

the iPad is sideways.

Portrait Subscription Tile Specify a 331x180-pixel background image that describes the Apple subscription when the 

iPad is upright.

Optional Library Subscription Tile URL Specify a URL with a 180-pixel wide banner that is displayed at the top of the 

library view.  This banner can include messaging that is not necessarily related to subscriptions.

Optional Remote Custom Dialog URL This URL loads when the customer completes the subscription process. For 

example, you can request user information or provide additional details about your products.

Subscription Products Click the plus icon to specify at least one Apple iTunesConnect product ID and corresponding 

duration.
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Important: Shared secret information is required for subscription apps. Use iTunes Connect to create or view your shared 

secret. Use the Account Administrator tool to specify the shared secret characters for the application account.

Icons and Splash Screens panel

Use this panel to specify app icons and splash screens that will appear in iTunes and the iPad.

29x29/50x50/72x72 icons The icons that you specify will be used on the iPad home screen when installed, and on the 

device App Store when viewed from the iPad. Provide 29x29, 50x50, and 72x72 pixel icons in PNG format. Apple 

rounds the corners automatically. Do not scale up smaller artwork. Use 72ppi, RGB, flattened, high-quality PNG files.

Note: Always include a .png extension in your image filenames.

Optional 512 x 512 artwork The large app icon will be displayed for your app on the desktop App Store and if needed, 

will be used to feature your app on the App Store. You can also specify this image while submitting your app to the 

Apple Store. Do not scale up smaller artwork. Use 72ppi, RGB, flattened, high-quality PNG files.

Shine on app icon Indicate whether you want your application icons to include the shine effect, which looks like a light 

is shining on the upper portion of the icon.

Shine off (left) and on (right)

Landscape Splash Screen When the Viewer is started, a splash screen appears for approximately three seconds. Specify 

a 1024x768, 72ppi, RGB, flattened, high-quality PNG.

For best results, make your splash screen image different from your cover. If the cover and the splash screen are 

identical, users may think the app is frozen when they first start it.

Portrait Splash Screen When the Viewer is started, a splash screen appears for approximately three seconds. Specify a 

768x1024, 72ppi, RGB, flattened, high-quality PNG.

Optional Fonts ZIP for HTML If you apply fonts to text in your HTML stacks or web view overlays, you can include 

them in either the .folio file or the Viewer. If you choose to include them in the Viewer, compress the fonts in a .zip 

folder. The .zip file should not contain subfolders; all content should be on the same level.

Newsstand

If you enable Newsstand, your viewer app appears in the Newsstand folder of iPads with iOS5 installed. To enable 

Newsstand, you must create a viewer app with iTunes subscription—either iTunes Subscription only or Entitlement 

with iTunes Subscription, but not Entitlement only. In addition, you must enable push notifications.

Enable Newsstand Select this option to allow your viewer to appear in the Newsstand folder.

Magazine/Newspaper Determine whether Newsstand should classify your viewer app as a magazine or newspaper.

Binding Edge Select an option to determine the adornment appearance on the Newsstand icon when a customer 

double-taps the Home button to display the active apps. For example, choosing Left binding displays a binding edge 

on the left and page adornments on the right.

Newsstand Icon Specify a 96x128 PNG icon that appears in the Newsstand folder. Use a 72 ppi, RGB, flattened, high-

quality PNG file at 95x128 pixels. This icon is used as the cover image in Newsstand. This icon is replaced by the cover 

image of the most recently published folio.
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Navigation Toolbar (Enterprise only)

This panel lets you customize the Navigation Toolbar that appears in your custom viewer at the bottom of the library. 

Show Navigation Toolbar Select this option to display the Navigation Toolbar at the bottom of the viewer.

Specify whether the Navigation Toolbar should appear in all views, including folio view, or if it should be hidden when 

folios are viewed. 

Hide Viewer Icon If Show Navigation Toolbar is selected, you can hide the Viewer icon that appears by default. 

Tapping the Viewer icon displays the previously viewed folio.

Hide Buy Buttons Select this option if you want folios to be available for purchase only through a subscription and not 

through individual purchase.

Hide Sign In Button Select this option if you want a Sign In button to appear in the upper left corner of the web page 

that appears when users tap any of the custom icons.

Hide Home Button If the Navigation Toolbar is displayed, tapping the the Library button does the same thing as the 

Home button. To avoid this redundancy, you can hide the Home button.

Icon Up State Click the plus icon on the right side of the panel to create a custom button for the Navigation Toolbar. 

Specify a 75x43-pixel PNG file to be displayed as the normal button appearance.

When users tap a custom icon, an in-app browser displays the contents of the HTML file you provide, such as a website 

for a store, a news feed, or help page. Customers can tap a Close button to return to library view. You can specify as 

many as three custom toolbar buttons.

Icon Down State Specify a 75x43-pixel PNG file to be displayed when the button is tapped. Make this .png image the 

same size as the up state image. For example, you can change the image border from black to red.

Icon Disabled State Specify a 75x43-pixel PNG file to be displayed when the button is not available, such as during a 

download. Make this .png image the same size as the up state image. For example, you can display a dimmed version 

of a shopping cart for a “Store” button.

Icon HTML Resources ZIP Specify a .zip file containing the assets to be used for the web view that appears when users 

tap the toolbar button. The .zip file should include a single HTML file and any required image and CSS files. The .zip 

file should not contain subfolders; all content should be on the same level.

Auto Launch One of the custom toolbar buttons can be set to Auto Launch. When Auto Launch is turned on, opening 

the viewer library displays the HTML page automatically.

Show Navigation Controls Display navigation controls such as a Back button and a Refresh button for the web page.

Note: Click the plus icon on the right side of the Navigation Toolbar panel to add as many as three custom buttons. You 

can also replace the default Library and Viewer buttons. Click the buttons in the preview bar to switch between buttons.

Provisioning

Apple requires all applications to be signed by a valid certificate and provisioned before they can be run on the iPad. 

In the Provisioning section, you specify the mobileprovision files. You specify the certificates when you download the 

generated viewer apps.

For information on creating certificates and mobileprovision files, see the iPad Publishing Companion Guide PDF 

which is available on the Dashboard.

Enterprise Signed Build Select this option only if you want to use an enterprise provisioning certificate for a viewer to 

be distributed only within your organization. Specify an App ID and your enterprise mobileprovision file. See 

“Creating an enterprise signed iPad viewer app” on page 100.

Distribution Mobileprovision The mobileprovision file determines which iPads can install and use your Viewer app.
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Developer Mobileprovision The mobileprovision file determines which iPads can install and use your viewer app. The 

mobileprovision file for the development app includes a list of iPad IDs called UDIDs.

Sideloadable Developer Build Select this option so that you can manually add .folio files to the development viewer 

through iTunes. You can use only .folio files, not .zip files created using the Export button in the Folio Producer 

Organizer.

Enable Push Notifications Select this option to enable Adobe push notifications. If you select this option, a red badge 

appears on the viewer app icon and indicates the number of available folios, or Newsstand displays a push notification. 

This option is required when Newsstand is enabled. 

Specify the production certificate and password that you create on the Apple developer site. To set up push 

notifications, configure your App ID, create new mobileprovision files, and create a productin push certificate. For 

detailed instructions, see the iPad Publishing Companion Guide PDF.

Use Adobe Push? At this time, only Adobe push notifications are available.

Build Details

If you signed in using an Adobe ID provisioned for Omniture tracking, settings for tracking user data appear on the 

Build Details page. This data is populated automatically. If you have an enterprise account and these options do not 

appear, contact your Adobe representative.

After you specify information or files for all mandatory fields, click Submit Build, and then click Finish.

The amount of time it takes to create the development and distribution apps depends on how busy the server is. 

Downloading and testing the viewer apps

Certificates are required for two different Viewer apps—a development app and a distribution app. The development 

app is for testing; the distribution app is what you submit to Apple once you test and approve the development app. 

1 Select your viewer app in the Manage page where your custom viewer builds appear.

2 Click Developer Viewer (.ipa) to download the developer app.

3 Specify your developer p12 certificate and password, and then click Download And Sign.

Developer P12 Certificate The .p12 file saves your certificate private key information. Creating the .p12 certificate 

requires you to use the Apple Developer site to create and download a certificate and then use the Keychain Access 

utility to export the private key of that certificate as a .p12 certificate.

Developer P12 Password When you create the .p12 certificate, you are prompted to create a password. Blank 

passwords do not work. If you used a blank password, create the .p12 certificate again with a real password.

4 Add the development app (.ipa) to your iTunes library, and follow the instructions in the “iPad Publishing 

Companion Guide.pdf” to test your app.

5 If the developer app works as designed, return to the Manage page in Viewer Builder and click Distribution Viewer 

(.zip). Specify the distribution certificate information, and click Download And Sign.

Submitting and managing the viewer app

After you download and test your custom viewer, submit the distribution viewer (.zip) to Apple.

Submitting the development app If your developer app works as designed, submit the distribution app (.zip) to the 

Apple Store. For details, see the iPad Publishing Companion Guide PDF.
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Changing the approval status When your submitted app is approved and appears in the store, please open Viewer 

Builder and click the Approval Status next to the custom app. Enter the information and click Submit. A link to your 

app will be added to the Digital Publishing Gallery.

Updating a build If you need to create different icons or make other changes, select the viewer app on the main page, 

and click Edit. Your information and selections remain intact. Make the necessary changes, and then submit the build 

again. Your app will be updated.

Deleting a build If you no longer need the developer and distribution apps, select the viewer app on the main page, 

and click Delete.

Create a custom viewer app for Android and Amazon devices

Use the Viewer Builder to create a custom Viewer app for Android and Amazon devices. You can create multi-folio 

viewer apps, not single-folio viewer apps. In-app purchases for Android Market are available. In-app purchases and 

subscriptions for Amazon Appstore should be available when the Amazon Fire becomes available. See Publishing 

Process for Android Mobile Devices.

The steps for creating viewer apps for the Android Market and Amazon Appstore are similar. For both workflows, you 

create an .apk file for submitting. You can create the same app for each store, and the apps can allow the same content 

to be downloaded. For example, the “DPS Tips” app appears in both Android Market and Amazon Appstore and offers 

the same folios for downloading. On an Android device, you can download the app from either store. On the Amazon 

Fire, you can download the app only from the Appstore. 

If you specify valid files and information, Viewer Builder generates a .apk file. If it works properly, submit the .apk file 

to the Android Market.

The information such as certificates and passwords that you provide is not stored on the Adobe server. Only the 

application files are stored on the Adobe server.

Create a custom viewer app

1 Obtain the required files and information. See “Checklist for multi-folio viewer (Android and Amazon)” on 

page 83.

2 Download and install the Viewer Builder.

The Viewer Builder is available on the Digital Publishing Suite Dashboard.

3 Start the Viewer Builder and sign in using a valid Adobe ID.

The Adobe ID you use to sign in to the Viewer Builder may be different from the Adobe ID you use to specify the 

Title ID in the Viewer Details panel.

4 Click New, select Android, and then click Next. 

5 Specify the requested files and information.

Viewer Details panel

The Viewer Details panel lets you provide your viewer names and account ID information.

Viewer Name Provide a viewer name that appears below the App icon. As a general rule, use 13 characters or fewer to 

avoid truncating the name.

To test your viewer name, add a bookmark to the Android home screen. 

Viewer Version Specify the most recent viewer.

http://blogs.adobe.com/digitalpublishinggallery/
http://kb2.adobe.com/cps/900/cpsid_90052.html
http://kb2.adobe.com/cps/900/cpsid_90052.html
https://digitalpublishing.acrobat.com/
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The Viewer Builder includes a previous version for backup purposes.

Viewer Type Specify the Adobe Hosted Multi Issue viewer type. If you’re an Enterprise customer, you can also choose 

Entitlement.

• Multi-Issue A multi-folio viewer app includes a library that lets users download content that is hosted on the Adobe 

Distribution Service.

• Multi-Issue with Entitlement (Enterprise only) Create a viewer app that uses a custom entitlement server to 

determine which customers can download content. If you select this option, you use your own subscription service.

• Multi-Issue with Amazon Subscription Create a viewer app that uses the Amazon Appstore subscription model. 

• Multi-Issue with Entitlement and Amazon Subscription (Enterprise only) Create a viewer app that uses a custom 

entitlement server to determine which customers can download content. Customers can subscribe either through your 

subscription service or through the Amazon Appstore.

Marketplace Choose an option to determine where your app can be submitted: Android Market or Amazon Appstore 

for Android. You can also choose None to create an app that you don’t intend to submit to a store.

Title (Library View) Provide the title that will appear at the top of the Viewer library. For best results, use no more than 

35 characters. At this time, use only alphanumeric or numeric characters. Do not use special characters such as 

apostrophes (‘), or unexpected results may occur on Android devices.

Title ID/Password Provide the appropriate Adobe ID and password for your app. Specify the same Adobe ID used for 

publishing the folios for this app.

Entitlement Details (Enterprise only)

The following options appear if you choose Entitlement for Viewer Type.

Note: For detailed information about setting up a custom entitlement server, contact your Adobe representative.

Integrator ID Adobe provides the Integrator ID when your entitlement account is provisioned within our servers. This 

option is available only to DPS Enterprise customers.

Create Account URL Specify the URL where customers can sign up for a subscription through the publisher. This URL 

is used when users tap a “Subscribe Now” button in your Viewer. If you leave this field blank, the corresponding 

section of the authentication dialog box is omitted.

Forgot Password URL Specify the URL where customers can retrieve their forgotten password.

Send App ID and Version This option allows the Viewer app’s ID and Version strings to be sent in entitlement API 

calls.

Entitlement Banner Enabled Select this option if you want to display an HTML banner in the viewer library when the 

device is connected to the web.

Banner Page URL Specify the URL containing content that appears in the upper section of the viewer library. 

Offline Banner Assets Select the .zip file containing the assets to be used as the banner if the user is not connected to 

the web. The .zip file should include a single HTML file, one or more image files, and no CSS files. The .zip file should 

not contain subfolders; all content should be on the same level.

Banner Height Specify the height of the banner displayed in the viewer library.
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Subscription Details panel

Use this panel to configure your viewer for Amazon subscription.

Landscape Subscription Tile Specify a 467x120-pixel (recommended) button image with a .png extension. This image 

appears in the libraray when the device is sideways.

Portrait Subscription Tile Specify a 255x145-pixel (recommended) button image with a .png extension. This image 

appears in the libraray when the device is upright.

Default Subscription SKU Specify the default subscription SKU for your Amazon subscription. This SKU can contain 

as many as 150 characters. Use the same SKU that you specify in the Amazon Appstore Developer Portal 

(https://developer.amazon.com). 

Custom Subscription Dialog URL (Optional) Specify a URL with a 180-pixel wide banner that is displayed at the top of 

the library view.  This banner can include messaging that is not necessarily related to subscriptions. Indicate whether 

this dialog box should be displayed before or after the customer purchases the subscription.

Icons and Splash Screens panel

Use this panel to specify app icons and splash screens that will appear in Android Market and on Android mobile 

devices.

36x36/48x48/72x72 icons The icons that you specify will be used on the Android home screen when installed, and in 

Android Market. Provide 36x36, 48x48, and 72x72 pixel icons in PNG format. Do not scale up smaller artwork. Use 

72ppi, RGB, flattened, high-quality PNG files.

Note: Always include a .png extension in your image filenames.

Landscape Splash Screen When the Viewer is started, a splash screen appears for approximately three seconds. Specify 

a 1280x800, 72ppi, RGB, flattened, high-quality PNG. 

Use the same splash screen for all Android devices. Make sure that the core design fits within the smaller target device 

region, such as 800x600. Treat the outer area as a bleed. When the splash screen appears on smaller devices, the outside 

areas of the image are cropped.

For best results, make your splash screen image different from your cover. If the cover and the splash screen are 

identical, users may think the app is frozen when they first start it.

Portrait Splash Screen Specify an 800x1280, 72ppi, RGB, flattened, high-quality PNG.

Optional Fonts ZIP for HTML If you apply fonts to text in your HTML stacks or web view overlays, you can include 

them in either the folio or the viewer. If you choose to include them in the viewer, compress the fonts in a .zip folder. 

The .zip file should not contain subfolders; all content should be on the same level.

Navigation Toolbar (Enterprise only)

This panel lets you customize the Navigation Toolbar that appears in your custom viewer at the bottom of the library. 

Show Navigation Toolbar Select this option to display the Navigation Toolbar at the bottom of the viewer.

Specify whether the Navigation Toolbar should appear in all views, including folio view, or if it should be hidden when 

folios are viewed. 

Hide Viewer Icon If Show Navigation Toolbar is selected, you can hide the Viewer icon that appears by default. 

Tapping the Viewer icon displays the previously viewed folio.

Hide Buy Buttons Select this option if you want folios to be available for purchase only through a subscription and not 

through individual purchase.

https://developer.amazon.com
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Hide Sign In Button Select this option if you want a Sign In button to appear in the upper left corner of the web page 

that appears when users tap any of the custom icons.

Hide Home Button If the Navigation Toolbar is displayed, tapping the the Library button does the same thing as the 

Home button. To avoid this redundancy, you can hide the Home button.

Icon Up State Click the plus icon on the right side of the panel to create a custom button for the Navigation Toolbar. 

Specify a 75x43-pixel PNG file to be displayed as the normal button appearance.

When users tap a custom icon, an in-app browser displays the contents of the HTML file you provide, such as a website 

for a store, a news feed, or help page. Customers can tap a Close button to return to library view. You can specify as 

many as three custom toolbar buttons.

Icon Down State Specify a 75x43-pixel PNG file to be displayed when the button is tapped. Make this .png image the 

same size as the up state image. For example, you can change the image border from black to red.

Icon Disabled State Specify a 75x43-pixel PNG file to be displayed when the button is not available, such as during a 

download. Make this .png image the same size as the up state image. For example, you can display a dimmed version 

of a shopping cart for a “Store” button.

Icon HTML Resources ZIP Specify a .zip file containing the assets to be used for the web view that appears when users 

tap the toolbar button. The .zip file should include a single HTML file and any required image and CSS files. All 

included files should be at the same directory level—subfolders are not supported.

Auto Launch One of the custom toolbar buttons can be set to Auto Launch. When Auto Launch is turned on, opening 

the viewer library displays the HTML page automatically.

Show Navigation Controls Display navigation controls such as a Back button and a Refresh button for the web page.

Note: Click the plus icon on the right side of the Navigation Toolbar panel to add as many as three custom buttons. Click 

the buttons in the preview bar to switch between buttons. You can also edit the appearance of the Library and Viewer 

buttons, but not the functionality.

Provisioning

Application ID Specify an application ID unique to the application. If possible, use the reverse domain syntax, such as 

“com.publisher.publication.” Use only periods, hyphens, and basic alphanumeric characters (a-z, A-Z, 0-9).

Build Details

After you specify information or files for all mandatory fields, click Submit Build, and then click Finish.

The amount of time it takes to create the development and distribution apps depends on how busy the server is. 

Testing the development app Download the .apk build, add it to one or more Android devices, and test the app. 

Follow the instructions in Publishing Process for Android Mobile Devices.

Downloading and testing the Android viewer app

When you download the generated .apk file, you are prompted to specify certificate information. Google requires all 

applications to be signed by a valid certificate before they can be run on Android devices. For instructions on creating 

this certificate, see Publishing Process for Android Mobile Devices.

1 Select your viewer app in the Manage page where your custom viewer builds appear.

2 Click Android Installer (.apk) to download the Android viewer app.

3 Specify your developer p12 certificate and password, and then click Download And Sign.

4 Add the .apk file to one or more Android devices.

http://kb2.adobe.com/cps/900/cpsid_90052.html
http://kb2.adobe.com/cps/900/cpsid_90052.html
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Submitting and managing the viewer app

After you download and test your custom viewer, submit the distribution viewer (.zip) to Android Market or Amazon 

Appstore.

Submitting the development app If your developer app works as designed, submit the app (.apk file) to the Android 

Market or Amazon Appstore. Follow the instructions in Publishing Process for Android Mobile Devices.

Changing the approval status When your submitted app is approved and appears in the store, please open Viewer 

Builder and click the Approval Status next to the custom app. Enter the information and click Submit. A link to your 

app will be added to the Digital Publishing Gallery.

Updating a build If you need to create different icons or make other changes, select the viewer app on the main page, 

and click Edit. Your information and selections remain intact. Make the necessary changes, and then submit the build 

again. Your app will be updated.

Deleting a build If you no longer need the developer and distribution apps, select the viewer app on the main page, 

and click Delete.

Create a custom viewer app for PlayBook devices

Use the Viewer Builder to create a custom Viewer app for PlayBook devices. You can create multi-folio viewer apps, 

not single-folio viewer apps. In-app purchases for PlayBook viewers are not available.

If you specify valid files and information, Viewer Builder generates a .bar file. If it works properly, submit the .bar file 

to the BlackBerry App World. See Publishing Process for BlackBerry PlayBook Mobile Devices.

Viewer Builder requirements for creating PlayBook viewer apps

System requirements:

• Mac OSX 10.6 Snow Leopard or later for viewer apps

• Internet connection

• Viewer Builder. Download the Viewer Builder from the Digital Publishing Suite Dashboard.

• Adobe AIR 2.6 SDK or later

• BlackBerry Tablet OS SDK for Adobe AIR

Create a custom viewer app

1 Obtain the required files and information. See “Checklist for multi-folio viewer (PlayBook)” on page 83.

2 Download and install the Viewer Builder.

The Viewer Builder is available on the Digital Publishing Suite Dashboard.

If you have installed a previous version of the Viewer Builder, move it to the trash before installing the new version.

3 Start the Viewer Builder and sign in using a valid Adobe ID.

The Adobe ID you use to sign in to the Viewer Builder may be different from the Adobe ID you use to specify the 

Title ID in the Viewer Details panel.

4 Click New, select PlayBook, and then specify the location of your PlayBook SDK. Click OK, and then click Next. 

5 Specify the requested files and information.

http://kb2.adobe.com/cps/900/cpsid_90052.html
http://blogs.adobe.com/digitalpublishinggallery
http://kb2.adobe.com/cps/915/cpsid_91589.html
https://digitalpublishing.acrobat.com/
https://digitalpublishing.acrobat.com/


95USING DIGITAL PUBLISHING SUITE

Assemble and Publish

Last updated 11/16/2011

Viewer Details panel

The Viewer Details panel lets you provide your viewer names and account ID information.

Viewer Name Provide a viewer name that appears below the App icon. As a general rule, use 13 characters or fewer to 

avoid truncating the name.

Viewer Version Specify the most recent viewer.

The Viewer Builder includes a previous version for backup purposes.

Viewer Type Specify the Multi-Issue viewer type. If you’re an Enterprise customer, you can also choose Multi-Issue 

with Entitlement.

Viewer Title (Library View) Provide the title that will appear at the top of the Viewer library. For best results, use no 

more than 35 characters.

Title ID/Password Provide the appropriate Adobe ID and password for your app. Specify the same Adobe ID used for 

publishing the folios for this app.

Entitlement Details (Enterprise only)

Note: For detailed information about setting up a custom entitlement server, contact your Adobe representative.

Entitlement Details information for Android and PlayBook viewers is identical. See “Entitlement Details (Enterprise 

only)” on page 91.

Icons and Splash Screens panel

Use this panel to specify app icons and splash screens that will appear in iTunes and the iPad.

86x86 icons The icon that you specify will be used on the PlayBook home screen when installed, and in BlackBerry 

App World. Provide an 86x86-pixel icon in PNG format. Do not scale up smaller artwork. Use a 72ppi, RGB, flattened, 

high-quality PNG file.

Note: Always include a .png extension in your image filenames.

Landscape Splash Screen When the Viewer is started, a splash screen appears for approximately three seconds. Specify 

a 1024x600, 72ppi, RGB, flattened, high-quality PNG. 

For best results, make your splash screen image different from your cover. If the cover and the splash screen are 

identical, users may think the app is frozen when they first start it.

Portrait Splash Screen Specify a 600x1024, 72ppi, RGB, flattened, high-quality PNG.

Navigation Toolbar (Enterprise only)

Navigation Toolbar information for iPad, Android, and PlayBook viewers is identical. See “Navigation Toolbar 

(Enterprise only)” on page 92.

Provisioning

Publisher Name Specify your publisher name. It is important to specify the exact same publisher name you specified 

when creating your certificate.

Application ID Specify an application ID unique to the application. If possible, use the reverse domain syntax, such as 

“com.publisher.publication.” Use only periods, hyphens, and basic alphanumeric characters (a-z, A-Z, 0-9).

Build Details

After you specify information or files for all mandatory fields, click Submit Build, and then click Finish.
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The amount of time it takes to create the development and distribution apps depends on how busy the server is. 

Testing the development app Download the .bar build, add it to one or more Android devices, and test the app. 

Follow the instructions in Publishing Process for BlackBerry PlayBook Mobile Devices.

Downloading and testing the PlayBook viewer app

When you download the generated .bar file, you are prompted to specify certificate information. RIM requires all 

applications to be signed by a valid certificate before they can be run on PlayBook devices. For instructions on creating 

this certificate, see Publishing Process for BlackBerry PlayBook Mobile Devices.

1 Select your viewer app in the Manage page where your custom viewer builds appear.

2 Click Distribution Viewer (.bar) to download the PlayBook viewer app.

3 Specify your signing PIN, developer p12 certificate, and password, and then click Download And Sign.

4 Add the .apk file to one or more Android devices.

Submitting and managing the viewer app

After you download and test your custom viewer, submit the distribution viewer (.zip) to Apple.

Submitting the development app If your developer app works as designed, submit the app (.apk file) to BlackBerry 

App World. Follow the instructions in Publishing Process for BlackBerry PlayBook Mobile Devices

Changing the approval status When your submitted app is approved and appears in the store, please open Viewer 

Builder and click the Approval Status next to the custom app. Enter the information and click Submit. A link to your 

app will be added to the Digital Publishing Gallery.

Updating a build If you need to create different icons or make other changes, select the viewer app on the main page, 

and click Edit. Your information and selections remain intact. Make the necessary changes, and then submit the build 

again. Your app will be updated.

Deleting a build If you no longer need the developer and distribution apps, select the viewer app on the main page, 

and click Delete.

http://kb2.adobe.com/cps/915/cpsid_91589.html
http://kb2.adobe.com/cps/915/cpsid_91589.html
http://kb2.adobe.com/cps/915/cpsid_91589.html
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Chapter 6: Analytics and Services

Omniture analytics

The Analytics page lets you track the user data of your custom Viewer app. When you subscribe to the Adobe Digital 

Publishing Suite, you get access to base-level analytics powered by Omniture®. This data includes the number of issues 

downloaded and purchased, the top content and ads, and the number of application installations.

Setting up Omniture Analytics

When you sign up for a Digital Publishing Suite subscription (Professional or Enterprise), you are assigned a master 

account ID that lets you use the Account Administration tool. Use this tool to assign the “Application” role to an 

Adobe ID. As part of that process, you provide the necessary information to enable Omniture analytics. Once you 

provide this information, it can take as long as five days to enable analytics. See “Account Administration tool” on 

page 98.

For more information on making sure that your analytics is set up properly, see Setting up Omniture Analytics. If your 

account is not set up properly, send an email request to dmpubsup@adobe.com.

If you have an account with Omniture® SiteCatalyst® and an Enterprise subscription, you get access to the full set of 

Omniture SiteCatalyst features at my.omniture.com.

View analytic data

1 Sign in to the Adobe Digital Publishing Suite Dashboard. 

Only a provisioned Adobe ID account lets you view the Analytics page. To view analytics, use the same Adobe ID 

that is used in the Folio Builder panel to upload content for your custom Viewer app.

2 Click Analytics.

Reports for your custom Viewer app are loaded.

3 To analyze your data, do any of the following actions:

View a different report On the left side of the Analytics page, click a different report type, such as Individual 

Purchases or Ads.

Change the date range Use the From and To calendar icons to specify a range of dates. Then click Update.

Specify the folio After you specify a date range, select the folio to view the data.

Sort data Click the column heading in any table to sort the data by that column. Click again to reverse direction, 

such as from A to Z or Z to A.

mailto:dmpubsup@adobe.com
https://my.omniture.com/login/
https://digitalpublishing.acrobat.com/
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Analytics data for a custom Viewer app

Sell digital content

You have a variety of different ways to sell your digital content through app stores, from a one-time sale of a single-

issue viewer to an ongoing subscription model. Available options vary based on which edition you have.

You can create and sell digital content using the Apple App Store, the Android Market, and BlackBerry App World.

Related Articles

Account Administration tool

With the Account Administration tool, you can create and provision accounts for your company. You can create 

assign three types of roles to accounts, all of which are based on Adobe IDs. See “Using Adobe IDs for digital 

publishing” on page 5.

To do this: Go here:

Understand the types of viewer apps “Types of custom viewer apps” on page 69

Create folios for mobile devices of different sizes “Creating documents for multiple devices” on page 27

“Create folio renditions” on page 79

Create a Single Edition viewer app “Single Edition overview” on page 8

Create a custom viewer app to submit to a store “Viewer Builder” on page 84

Create an enterprise-signed iPad application for internal distribution 

only

“Creating an enterprise signed iPad viewer app” on page 100
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Account Administration tool
A. Master account  B. Accounts assigned Application roles  C. Creative account with no roles assigned  

Administrator When you subscribe to the Digital Publishing Suite, one account from your company is assigned the 

Administrator role. This is called the master account. With this account, you can use the Account Administration tool 

to assign roles to accounts. You cannot remove the master account.

Application With an application role, you can associate a custom viewer with published folios. Use a different Adobe 

ID for each custom viewer you create. For example, if you publish multiple dance magazines, you can create one Adobe 

ID for ballet (dps.ballet@danceweek.com), one for line dancing (dps.line_dancing@danceweek.com), and so on. 

Use the Application account to publish folios, and specify the Application ID in the Viewer Builder.

Viewer Builder With a Viewer Builder account, you can sign in to the Viewer Builder and create custom viewer apps. 

You can use the same Adobe ID for both the application account and the Viewer Builder account. 

Note: Do not use this tool to add individual designers to your company account. Create an Adobe ID using this tool only 

to create an application account and assign one or more roles. If you add an individual’s Adobe ID using this tool, that 

Adobe ID is tied to the company account.

1 Sign in to the Adobe Digital Publishing Suite Dashboard. 

2 Click Account Administration.

If the Account Administration option is dimmed, the account you used to sign in does not have Administrator 

privileges. If you sign in using your primary account ID and don’t have access to the Account Administration tool, 

please send a message to dmpubsup@adobe.com to request that your account be enabled. Once the primary 

account is enabled, that user sign in and enable additional administrator accounts.

3 In the Account Administration panel, click Add New Users.

4 In the New Users dialog box, do either of the following:

• For an existing Adobe ID, specify the Adobe ID of the user you want to modify, and click Submit.

• To create a new Adobe ID, click Create A New Adobe ID, specify the information, and click Create Account. 

Use this option for Application Adobe IDs such as “dps.publication@publisher.com.” Do not use the Account 

Administrator tool to create Adobe IDs for individuals.

5 In the Account Administration panel, select the user, and click Configure User.

6 Under Add Roles, specify the role type—Application Accounts, Viewer Builder Accounts, or Account 

Administrator—that you want to assign to the account. Click Enable, and fill out the necessary information.

When you assign an Application account, you can specify shared secret information. Shared secret information is 

required only for subscription viewer apps. For details on obtaining a shared secret, see the publishing guide 

associated with the platform.

A

B

C

https://digitalpublishing.acrobat.com/
mailto:dmpubsup@adobe.com
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Assigning an Application account to an Adobe ID

You can also specify information to set up an Omniture analytics account. When you submit this information, it 

can take as long as five business days to set up Omniture analytics for your app. See “Omniture analytics” on 

page 97.

Creating an enterprise signed iPad viewer app

If you have an Enterprise edition of the Digital Publishing Suite, you can create iPad apps for internal distribution only. 

An enterprise signed iPad viewer app is distributed within the company rather than downloaded from the Apple Store.

A subscription to Apple’s iOS Developer Enterprise Program is required to create an in-house viewer app. An Apple 

enterprise subscription costs $299 a year and removes the 100-device limit for development apps. For more 

information on using the Developer Enterprise Program, see the Enterprise Deployment Guide.

1 Sign in to the Apple iOS Dev Center using an enterprise ID, and create an enterprise .p12 certificate and 

mobileprovision files.

2 In the Folio Producer web client, publish folios to be included in your in-house app using Free and Private settings. 

To avoid external distribution, do not set the status to Public.

3 In the Viewer Builder, specify details in the Basic Details and Splash Screen panels.

4 In the Certificates section of the Viewer Builder, specify your development and distribution .p12 certificate, 

password, and mobileprovision file information.

The distribution details are not used for your in-house app and should not be submitted to the Apple Store.

5 Select the Enterprise Signed ID option, and specify the Intended Application ID.

http://developer.apple.com/programs/ios/enterprise/
http://manuals.info.apple.com/en_US/Enterprise_Deployment_Guide.pdf
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The Intended Application ID is usually in the “com.publisher.publication” format.

6 Build the app, and download the development Test Viewer (.ipa) file.

7 Distribute the mobileprovision file and the .ipa file through email or a server. Instruct users to install both files by 

dragging them into their iTunes library and syncing with the iPad.

Subscriptions and entitlement

In-app subscription options are now available on iOS and Amazon. You have a variety of subscription options 

available, including Apple’s new subscription model (Professional and Enterprise only) and a custom entitlement 

server (Enterprise only).

Apple and Amazon subscriptions

When users subscribe to your app through iOS or Amazon subscription, they are entitled to all folios in which the 

Publication Date falls between the start date and end date. They’re also entitled to the most recently published folio 

when they first subscribe. For example, if a user signs up for a six-month subscription on November 10, the start date 

is November 10 and the end date is May 10. After subscribing, the user can download the most recently published folio 

as well as any folio in which the Publication Date is between Nov. 10 and May 10. If users don’t renew the subscription, 

they are still entitled to those six months of content. 

As a best practice, you should use the Folio Producer Organizer to manage your Publication Date settings for your 

folios. If you publish a quarterly magazine, use consistent publication date settings, such as January 1, April 1, July 1, 

and October 1, even if you actually publish those folios on different dates. As long as you continue publishing 

consistently, your subscribers will be entitled to the appropriate amount to content. 

For information on setting up subscriptions and entitlement for custom iPad viewer apps, obtain the iPad Publishing 

Companion Guide PDF from the DPS Dashboard. For information on setting up subscriptions for Amazon Appstore 

apps, see the Amazon publishing guide.

Custom entitlement servers

For information on setting up a custom entitlement server to control subscriptions through your own site, contact 

your Adobe representative.

Push notifications

When users open the Viewer library, the Adobe Content Viewer indicates that a new or updated folio is available. 

Setting up push notifications displays a red badge on the app icon that notifies you customers when a new folio is 

available.

Push notification indicates that one new folio is available

For information on setting up push notifications for custom iPad viewer apps, download the iPad Publishing 

Companion Guide PDF from the DPS Dashboard.

https://digitalpublishing.acrobat.com
https://digitalpublishing.acrobat.com
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